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AV-8B MAP SYSTEM Ih: MOVING-MAP COMPOSER (MMC)

VERSION 3.5, SOFTWARE USERS' MANUAL (THIRD EDITION)

1. INTRODUCTION

This report documents the Moving-Map Composer (MMC) software system developed by scientists in
NRL Code 7440.1. This is the third edition of the MMC Users' Manual (the first and second editions are
NRL/FR/7441--97-9677 and NRL/FR/7440--00-9938, respectively). The third edition reflects changes
that were implemented for the latest release (version 3.5) of MMC.

The MMC software is resident on the Map-Il Station portion of the AV-8B Mission Support System,
which NRL designed and configured in support of AV-SB mission planners and pilots in the field. MMC
enables users to perform the following functions:

"* Design and build Aircraft Optical Disk (AOD) images from user-specified Compressed
Aeronautical Chart (CAC) and scanned chart data;

"* Include and edit emergency checklists and other dataframes (such as reconnaissance
photographs) in an AOD image;

"* Write completed AOD images to militarized Write-Once Read-Many AODs;

"* Evaluate failed AODs and recycle failed AODs when possible;

"* Design and build Mission Planning System Compact Disk Images (MPS-CDIs) from user-
specified CAC, scanned chart, and DTED data;

"• Write MPS-CDIs to recordable compact disk (CD-R) for mission planning purposes;

"* Scan and compress paper charts into a CAC-compatible format (when CAC is not available)
and include them in an AOD image or MPS-CDI.

"* Print final compositions, CAC images, checklists, and AOD summaries.

The AV-8B Map-Il stations have completely replaced all map data functions and all optical disk image
functions that previously were handled by the AV-8B Map, Operator, and Maintenance Stations
(MOMS). To date, the AV-8B program has purchased eight NRL-developed Map-li stations (including
two for the Spanish AV-8B and one for the Italian AV-8B), and the F/A-18 program has purchased two.

2. SYSTEM CONFIGURATION

2.1 Hardware

Figure 1 illustrates the AV-8B Map-4l hardware components and the data flow between each of these
components. Figure 2 shows the Small Computer Standard Interface (SCSI) and General Purpose
Interface Board (GPIB) connections for the AV-8B Map-Il workstation and peripherals. Appendix A
defines each of these components in detail, and Appendix B describes how to set up the Map-Il hardware.

Manuscript approved August 21, 2002.
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Fig. 2- AV-8B Map-TI SCSI and GPIB connections
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MMC Version 3.5 Software Users' Manual 3

2.2 Software

Figure 3 is a simplified diagram of the principal MMC software operations: the MMC user inputs up to
three primary data sources (CAC, DTED, and scanned charts) from which MPS data and AOD data are
processed and archived.

Figures 4 and 5 illustrate how to build an AOD or MPS composition using two different methods
(depending on available data). Figure 4 shows how to build a new, user-defined composition from
"scratch," while Fig. 5 shows how to build a new composition from a pre-existing composition (when the
user may or may not have all the source data available).

The next two sections provide more detailed information on the MMC software. Section 3 describes
the MMC Graphical User Interface (GUI), including the world map workspace, tool bars, and all
associated utilities. Section 4 provides step-by-step instructions on how to perform the most common
MMC operations. This section was derived from a Tutorial that NRL developed for the initial installation
of the Map-Il workstation in China Lake, California; Rota, Spain; and Aviano, Italy.

A glossary of terms and definitions is provided in Appendix C.

Moving Map Composer
Functional Diagram

Sources Ouyu
CAC A MPS CD

OTED AOD
(WORM)

Scanned IsDevelop Mao p Archival
Paper Composi tion
chartsCoosto

Fig. 3 - Primary MMC software functions



4 Myrick et al.

Functional Diagram: User-Defined Composition
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Fig. 4 -Building a user-defined AOD or MPS composition
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Composition(s) or Image(s)
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Fig. 5 -- Building a new AOD or MPS composition from a pre-existing composition

3. MMC GRAPHICAL USER INTERFACE

3.1 Starting MMC

To start MMC, log in to the MMC account. MMC automatically starts after a successful login. After

several seconds, the main MMC Window will appear (Fig. 6). Sections 3.2 and 3.3 provide detailed

descriptions and illustrations of the various functions and utilities that MMC provides.
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Fig. 6- Main MMC window

3.2 Toolbars and Workspace Definitions

3.2.1 World-Map Workspace

As shown in Fig. 6, the largest portion of the main MMC Window is a world base map on which to
design AODI and MPS-CDI compositions. We recommend that the user zoom-in to an area of interest
before designing a composition or adding overlays, to optimize performance (e.g., speed up the graphics).
MMC provides vertical and horizontal scroll bars at the right side and bottom of the base map to allow the
user to scroll through the area of interest if the computer screen is not large enough to display it in its
entirety.

3.2.2 Title Information

MMC provides six blocks of information in a title bar (Fig. 7) just above the base map:

Fig. 7 - MMC title bar

1. A descriptive title for the AODI or MPS-CDI.

2. A unique filename (10 characters or less) for a final composition (this will also be used as a volume
label when archiving to CD).

BEST AVAILABLE COPY
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3. A unique library ID number for the AODI or MPS-CDI. This ID number uses the format TTT-yyyy-
vvv-Mcccccc, where

"* TTT = the image Type ('AOD' or 'MPS');
", yyyy = the year the image was created;
"* vvv = the version number of the image (001 through 999);
"* M= the Map station ID: a base-36 number (0-9, A-Z) that identifies which map station created the

original template(s) for this composition. Up to 36 individual map stations can be identified by
this ID, of which 11 have been assigned (Table 1).

Table 1 - ID Numbers, System Names, and Locations of
Map-Il Stations

M System Name Location

0 VOODOO NRL, Stennis, MS (old NRL computer; no DMU)
I MOE NAWC-AD, China Lake, CA
2 LARRY MCAS Cherry Point, NC
3 CURLY NRL, Stennis, MS

4 SHEMP MCAS Yuma, AZ
5 MAP005 Spain
6 MAP006 Spain
7 MAP007 Italy
8 MAP008 Hughes, Indianapolis, IN
W MMC Finland
X HARPO NRL, Stennis, MS (Finn F/A-18 owned)
Y JED NRL, Stennis, MS (F/A-18-owned)
Z GRANNY NRL, Stennis, MS (F/A-18-owned)

", cccccc = a composition ID (000001 through 999999) unique for map station M. Two different
map stations may create two different compositions with the same composition ID, but the map
station ID (M, above) makes the image library number unique. This way, a user on one map
station is not required to keep track of composition IDs on other map stations.

4. The chart series currently in use. To change the series, click on the Chart Series/Map Scale selection
box (Section 3.2.6) in the lower-right corner of the MMC Window.

5. The type of image currently being created ('AOD' or 'MPS').

6. A clock displaying the current date and time. To reset, login to the SYSTEM account, then type SET
TIME=dd-mmm-yyyy:hh:mm:s.s at the $ prompt. For example: SET TIME=20-JUL-
1997:16:31:0.0 will set the clock to July 20, 1997, 4:31 pm. To verify the current date and time, type
SHOW TIME. The system will print the current date and time. When finished, logout of the
SYSTEM account and return to the MMC account.

3.2.3 Coverage Definition Buttons

The coverage definition buttons (Fig. 8) allow a user to define coverage areas in four ways: 1) using
the mouse to pick points and define a polygon; 2) entering a series of lat/lon points to define a polygon; 3)
using the mouse to draw a "rubber band" box around a coverage; and 4) picking individual CAC
segments. Note that when a button's icon is light gray, it is not currently available for use.
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Fig. 8 - Coverage definition buttons

3.2.3.1 Select / Unselect Coverage Area

- The Arrow button is deactivated until the user has defined at least one area of coverage (Section
3.2.3.2). When ready, click on this button, then click on individual area(s) of coverage to be cut
(or copied) and pasted between different chart series. Alternatively, to select or unselect ALL
areas of coverage at one time, click on one of the Edit Menu options: Select ALL Coverages or
UnselectAll Coverages. As a coverage is selected, it turns yellow.

3.2.3.2 Define an Area of Coverage

Use any combination of these three buttons to define an area or areas of map coverage for inclusion in
an AOD image or MPS CD image template.

The Polygon Vertices button defines an irregularly shaped area. Click on this button, then click
on a set of points on the world map with the left (first) mouse button. The points will define the
vertices of a polygon, which in turn defines the coverage area. To close the polygon and fill the
defined area with segments, double-click with the left mouse button.JThe Define Coverage by Latitude / Longitude Coordinates button defines an area bounded by
specific latitude and longitude points. When a user clicks on this button, MMC pops up a
Latitude / Longitude Entry Window (Fig. 9). Enter each geographic coordinate pair
(Latitude, Longitude), indicate whether that coordinate crosses 180' longitude (relative to the

previous coordinate), then click on the Accept New Entry button. As each pair is entered, MMC will list
it in the Latitude / Longitude Entry Window. The user can edit the entries before accepting the
coverage area:

* To delete a record, click on its entry in the list, then click on Delete.

* To edit a record, click on its entry in the list, click on Edit, then edit the Latitude, Longitude,
and Cross-180 entries in the top half of the window.

* To start over, click on Clear all coordinates.

* When all coordinates are listed correctly, click on Accept Coordinates. The main MMC
Window will return, and the defined template will appear on the world map.

* To cancel from the Latitude / Longitude Entry Window and not save the points as a
template, click on Cancel. The main MMC Window will return.

BEST AVAILABLE COPY
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Please enter Latitude and Longitude
I In degrees minutes seconds"

Latitude Longitude
iDeg Min Sec N/S Deg Min Sec WE:

l i I i"d"

I "

e No

F cep Ne fnry Arro'p F uw7 r

tat ton cross 190?

Fig. 9- Latitude/Longitude entry window

SThe D~efine Coverag'e by a Stretch-Box button defines a rectangular area of coverage using a
"rubber-band" box. Click on this button, then click on the upper-left corner of the area to be
defined with the left (first) mouse button. Hold the mouse button down and drag the
resulting stretch-box to encompass the desired area. Note: the rubber banding only works

from upper-left to lower right! As long as the mouse button is held down, the stretch-box will be
adjustable. As soon as the box is satisfactory, release the mouse button. Click once more with the left
mouse button to accept the coverage area and fill the-box with segments.

3.2.3.3 Erase an Area of Coverage

These buttons are deactivated until the user has defined at least one area of coverage with one or more
of the previous three buttons (Section 3.2.3.2). Use any combination of the following three buttons to
erase areas of map coverage (i.e., remove coverage from an AOD image or MPS CD image template).

- The Erase Coverage .by Clicking Polvgon Vertices button erases an irregularly shaped area.
Click on this button, then click a set of points on the world map with the left mouse button.

S The points will define a polygon enclosing the area to be erased. To close the polygon and
erase the area, double-click with the left mouse button.
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' The Erase Coverage by Latitude / Longitude Coordinates button erases an area bounded by
specific latitude and longitude points. When the user clicks on this button, MMC pops up the
Latitude-Longitude Entry Window (Fig. 9). For more details, refer to Section 3.2.3.2.

The Erase Coverage by a Stretch-Box button erases a rectangular area of coverage. Click on this
button, then click on the upper-left comer of the area to be erased with the left (first) mouse
button. Hold the mouse button down and drag the resulting stretch-box to encompass thedesired area. Note: the stretch-box only works from upper-left to lower right! As long as the

mouse button is held down, the stretch-box may be adjusted. As soon as the box is satisfactory, release
the mouse button. Click once more with the left mouse button to erase the enclosed area.

3.2.3.4 Set / Clear Individual Segments

SUse the Set/Clear button to individually select segments to be added to or deleted from a
template. In other words, this button acts as a toggle to select and deselect individual segments.

3.2.4 Zoom Buttons

The Zoom buttons (Fig. 10) allow a user to zoom into (or out from) an area of interest on the MMC
base map. Zooming can be done via a "stretch box" or by selecting a zoom factor and then zooming in or
out by that factor. Note that when a button's icon is gray, it is not available for use. For example, the
Zoom-out button will be unavailable until the user has zoomed in.

A2x

Fig. 10-Zoom buttons

3.2.4.1 Zoom-in on a Stretch-Box

Zoom-in on a Stretch-Box button zooms to an area of interest with a "stretch box." Click on
Mthis button, then, click on the upper-left comer of the area of interest with the left (first) mouse

button. Hold the mouse button down and drag the resulting stretch-box to the lower-right
I comer of the area of interest.

Note: the stretch-box only works from upper-left to lower right! As long as the mouse button is held
down, the stretch-box may be adjusted. The box maintains a constant aspect ratio identical to that of the
display screen. This ensures that the contents of the final stretch-box fit perfectly on the display. As soon
as the box is satisfactory, release the mouse button, then click again with the left mouse button to perform
the zoom (Fig. 11).
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(a)

Fig. II- Zooming in with a stretchbox, (a) before zoom and (b) after zoom
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3.2.4.2 Zoom-out by a Specified Zoom Factor

The Zoom-out from a Point button zooms out from the MMC base map. Click on this button,
4 adjust the zoom factor (Section 3.2.4.4), and then click on the map to zoom-out (the map will

center on the selected point). Note: the user cannot zoom-out until he or she has zoomed in!
This button will appear light gray when it is unavailable.

3.2.4.3 Zoom-in by a Specified Zoom Factor

:::-: The Zoom-in on a Point button zooms in to the MMC base map. Click on this button, adjust
the zoom factor, and then click on the map to zoom-in (the map will center on the selected
point). This button will turn light gray when the maximum zoom-in has been reached.

3.2.4.4 Specify the Zoom Factor

[Zoo- -r Click on the arrows to change the Zoom factor (default = 2x). This value dictates how
FOOM much to zoom-out or -in. For example, with the Zoom factor set to 8, clicking on the

Zoom-in button will zoom into the world map by 8:1. The maximum Zoom factor is
200.

Two special settings are available below factor 2: PAN and ONE. To pan (i.e., scroll) around the world
map, set the Zoom factor to PAN, click on either the Zoom-in or Zoom-out button, then click on the map
with the left mouse button. MMC will redraw the map centered on the point selected. For example,
clicking on the left edge of the map will scroll to the left. To return to the original, unzoomed, world
map, set the Zoom factor to ONE, click on either the Zoom-in or Zoom-out button, then click anywhere on
the world map.

3.2.5 Map Projection Selection Box

1 .......... --.. , , II I. Choose a map projection from this drop-down list: Mercator [default], North
t Mercator - y or South Polar. Use North Polar to work with data in the North Polar TS

"zone (North Polar segments will be displayed in dark green); use South Polar to
work with data in the South Polar zone (South Polar segments will be displayed in yellow); and use
Mercator for all other work. (See Appendix C.2 for information on TS zones.) Note: if the user tries to
select individual segments in a polar TS zone, but the MMC base map is displayed in Mercator, the
mouse pointer may appear to be "off' by I or 2 segments. Switch to the correct Polar projection to fix
this problem.

3.2.6 Chart Series and Scale Selection Box

I1C(:-... J 1 2 . Choose a chart series and associated scale from this drop-down list: JNCNC ;(1:2 ONC (0:1M); TPC (1:500k) [default]; JOG (1;250k); TLM-100
(1:100k); TLM-50 (1:50k); or DTED (for MPS only). Users can define

coverages in one series, then switch to another series without losing what they've defined in the first.
Users can also cut or copy coverages from one series and paste them into another (see Edit menu options
Cut, Copy, and Paste in Section 3.3.2.2). Note: DTED selection is active only when building an MPS
composition. DTED cannot be written to an Aircraft Optical Disk (AOD).
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3.2.7 Cursor Position Box

Latltude/Longitude- This information box shows the current geographic position of the cursor on the
-.2 2 E MMC base map. Position is shown in decimal degrees of latitude and longitude or

degrees, minutes, and seconds (depending on which is set in the Preferences menu,
View Latitude/Longitude, Section 3.3.5.3). Use this box to help find areas of interest.

3.3 Top Menu Bar

3.3.1 File

The File menu (Fig. 12) lets a user open a composition or image file, save a composition, and exit
from MMC.

Fig. 12- File menu

3.3.1.1 New (Ctrl+N)

Opens a new file in preparation for building an AODI or MPS-CDI composition. Only open a new
file to build a unique AODI or MPS-ODI. See the 0pen options (below) for alternatives to New. If a user
was designing a composition and did not save it before selecting Lew, MMC will issue a warning
message and the chance to save the work prior to starting a new file.

3.3.1.2 Open Working Composition (Ctrl+W)

Opens a file containing a composition-in-progress for an AODI or MPS-CDI. Unlike a final
composition, a working composition has no library number. In addition, MMC does not place any size
restrictions on working files, so the user may build a large "master" composition as a working file, then
break it into smaller compositions for final files. When the user selects Open Working Composition,
MMC displays a list of working compositions from which to choose (Fig. 13). After choosing a
composition, MMC returns to the base map and displays the selected composition (Fig. 14). At this point,
the user can view the map data defined by the composition or modify the composition.
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3.3.1.3 Open Final Composition (Ctrl+F)

Opens an existing file containing a final AODI or MPS-CDI that has been assigned a library number.
When a user selects Open Final Composition, MMC provides a list of current final compositions (Fig.
15) from which to choose. After the user chooses one, MMC returns to the base map and displays the
selected composition (Fig. 16). At this point, the user can view map data defined by the composition or
modify the composition and save it under a new name.

Fig. 13- Sample list of working compositions

BEST AVAILABLE COPY
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Moi g"..• map ..P~se (va..

Fig. 14- Sample working Composition displayed on MMC base map

Fig. 15- Sample list of final compositions
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* 0, ..

Fig. 16--Sample final compositions displayed on MMC base map

3.3.1.4 Open Image (Ctrl+I)

Opens an existing AOD or MPS image, builds a composition based on the image, and loads the
composition into MMC for viewing and modification. After the user selects Open Image, MMC queries
with a selection box for the image type (AOD or MPS) and then again for the device (CD, AOD, hard
disk). If the user selects to open the image from CD, MMC will provide a GUI for selecting and
mounting the necessary CD in an available drive. See Section 4.1 for more information about mounting
CDs in MMC.

3.3.1.5 Open Intermediate Data (Ctrl+O)

Opens intermediate (i.e., downsampled but not yet compressed) data files for display and review.

3.3.1.6 Save As Working Composition (Ctrl+S)

Saves the current composition as a working file, with no associated AOD / MPS-ODI library number.
MMC does not place any size restrictions on working files, so the user may save a large "master"
composition as a working file, then break it into smaller compositions for final files. MMC ofily keeps
one version of each working filename; if the user tries to save a working file with a filename that already
exists, MMC will ask if the user wants to overwrite the preexisting working file.

3.3.1.7 Save As Final Composition (Ctrl+M)

Saves the current composition as a final file, with a unique AOD or MPS-ODI library number. MMC
restricts final compositions to the maximum size of the ODI type selected: AODI (260 MB) or MPS-ODI
(600 MB). This size restriction is enforced prior to saving the final composition. If the user tries to save a
file that is larger than these maximums, MMC will instruct the user to trim some data off of the image
first. By default, MMC builds the composition for an MPS-ODI; the user must specify that the
composition will also be saved as an AODI file. MMC prompts the user for the final filename and
description. Final filenames must be 10 characters or less, and can only contain alphanumerics (e.g., no
"","-" etc.). Also, if the composition is too big to save to an AOD (over 245 MB), MMC will issue a
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warning message that there will not be enough space to write dataframes. The user may choose either to
continue or to edit the composition. If the user chooses to edit the composition, MMC will display a
message describing which scale(s) contain too much data, then give instructions on how to fix the
composition before reattempting the save.

3.3.1.8 Close(Ctrl+T)

Closes the current composition and refreshes the main MMC Window. If the user has made unsaved
changes, MMC will issue a warning and provide an opportunity to save the work prior to closing.

3.3.1.9 Exit (Ctrl+E)

Closes the current composition and exits from MMC. If the user has made unsaved changes, MMC
will issue a warning and provide an opportunity to save the work prior to closing.

3.3.2 Edit

The Edit menu (Fig. 17) provides utilities to select coverages, cut (or copy) and paste coverages
between scales, and undo or redo previous actions.

I .

Fig. 17- Edit menu

3.3.2.1 Undo (Ctrl+Z) I Redo (Ctrl+R)

Undo undoes the previous edit action (e.g., Cu_). Redo repeats the previous action.

3.3.2.2 Cut (Ctrl+X) / Copy (Ctrl+C) / Paste (Ctrl+V)

To cut or copy one or more coverages from one scale to another, click on the Arrow button (Section
3.2.3.1), then click on each coverage area to be cut or copied (the selected coverages will turn yellow),
then choose Cut or Copy. Alternatively, choose the Edit option Select All Coverages (described below),
then choose Cut or Copy. Warning: only the most recent Cut or Copy action stays in memory. If the user
Cut one coverage, and then Cut or Copy another before pasting the first, the first coverage will be lost
forever!
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* Cut cuts the selected coverage from the current chart series and temporarily stores it in
memory (to be pasted in another series, if desired).

* Copy makes a copy of the selected coverage and stores it in memory.

* Paste pastes the most recently cut or copied coverage from memory onto the current
coverage.

3.3.2.3 Select All Coverages (Ctrl+A) / Unselect All Coverages (Ctrl+U)

Select All Coverages selects all available coverages from the current chart series (all coverages will
turn yellow) for cutting or copying and pasting. Unselect All Coverages deselects selected coverages at
the current map series.

3.3.3 Overlays

The Overlays menu (Fig. .18) includes options to refresh the display and overlay shorelines, political
boundaries, latitude and longitude grid, user-defined coverage polygons, and available data coverages.
Options are selected with a toggle button that turns red when chosen.

Fig. 18• Overlays menu

3.3.3.1 Refresh Display (Ctrl + Y)

Redraws the current map information in the MMC Window.

3.3.3.2 World Vector Shoreline (WVS; Ctrl + H)

The base map for MMC and a standard product from the National Imagery and Mapping Agency
(NIMA). This overlay draws the shorelines of the world and is ON by default (Fig. 19(a)).
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3.3.3.3 Political Boundaries (Ctrl + P)

This overlay (ON by default) displays political boundaries between inland countries and states to
provide a more robust base map (Fig. 19(a)). Figure 19(b) shows the WVS overlay ON and the Political
Boundaries overlay OFF.

'f

(a) (b)
Fig. 19--MMC base map with (a) both WVS overlay ON and political boundaries overlay ON (default);

and (b) with WVS overlay ON and political boundaries overlay OFF

3.3.3.4 Lat / Lon Grid (Ctrl + L)

This option displays a user-defined grid of latitude and longitude lines (OFF by default: Fig. 19(a)).
When the user turns this overlay ON, MMC will prompt for the grid spacing (default is 100 in latitude
and longitude). Figure 20 shows the Lat/Lon Grid ON with a 20' grid.

50.ON - _! •

30.ON ____

Fig. 20-- MMC base map with latitude/longitude grid overlay ON

3.3.3.5 User Defined Polygons (Ctrl + D)

This option outlines each coverage the user defines. These polygons are useful in selecting specific
coverages for Cut and Paste operations. This overlay is ON by default (Fig. 21(a)). When it is OFF (Fig.
21(b)), adjacent coverages are not as easy to distinguish.
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(a) (b)

Fig. 21 - MMC base maps with user-defined polygons overlay (a) ON and (b) OFF

3.3.3.6 Available Coverage (Ctrl + B)

This option displays all logged CAC coverage for the current map scale in light gray (Fig. 22(a)), all
scanned chart coverage for the current scale in tan (Fig. 22(b)), and areas that contain both CAC and
scanned chart data in purple (Fig. 22(c)). This overlay is OFF by default. Note: if the user is designing
an MPS image and selects DTED from the Chart series selection box (Section 3.2.6), Available
Coverage will reflect all logged DTED coverage.

(c)

Fig. 22 - Available coverage (of data sources) overlays: (a) CAC only; (b) CAC (gray) abutting scanned
charts (tan); (c) CAC (gray) surrounding area with both scanned charts and CAC (purple).

3.3.4 Coverages

The Coverages menu (Fig. 23) provides utilities to include one or more compositions, images, or
scanned data sets in a new composition.
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Fig. 23 - Coverages menu

3.3.4.1 Include Working Composition

This option retrieves a working composition for either an AODI or MPS-CDI. MMC will present a
list of available compositions and prompt for which one to include. A modified working composition
may be saved under the same name or a different name. If it is saved under the same name, the original
will be deleted.

3.3.4.2 Include Final Composition (Ctrl+Insert)

This option retrieves a final composition from the hard disk. MMC will present a list of available
compositions and prompt for which one to include. Modifications to a final composition may only be
saved under a new name.

3.3.4.3 Include Image (Ctrl+J)

This option dynamically creates a temporary composition from a source image that can then be used to
define a new composition (or supplement an existing one). This option will retrieve the composition of
either an AOD or MPS image from the hard disk, a CD, or an AOD. If the user selects to open the image
from CD, MMC will provide a GUI for mounting the CD in an MMC drive (see Section 4.1). 'Finally,
MMC prompts for the source image filename. Note: If the source image is comprised of map data that
has not been logged into the system, a warning will appear and only map data that has been logged will
be shown.

3.3.4.4 Include Logged Source Coverage (Ctrl+Q)

This option builds a composition from a source coverage via a menu selection (Fig. 24). Valid source
coverages are CAC and DTED CDs that have been logged into MMC. The menu selection box provides
four columns of information for each entry: Info File name, CAC library number, date CAC was logged
into MMC, and a geographic coverage description. CAC Info Files are named after the library number of
their respective CAC CD. Note that some CAC CDs do not have an Info File (the first column lists
000000 instead of an Info File name, and the last column lists 'No Info File Located' instead of a
descriptive title). CAC CDs without Info Files do not have any geographic description associated with
them.



22 Myrick el al.

iterrs

ED-1992-4A--WP3-00011 CD-1992-A-VhAP3-00011 Fri Mar' 7 13:26:30 1997 'China and Indi a'

Cfl-1992-A- Wi3-00014 CD-1992-A-WMA3-00014 'Fri Feb 2 11 09:16:02 1997 -Australia'

000000 CD-199-A-Mr`i5-00008 Thu Oct 31 10:39:37 1991 'No Info File Located'

selection

ICD-1992-A--MAP3-00015 CD-1992--A-MAP3-COOJB5 Thu Feb 20 15:00:26 1997 'South Alnerlcal

Fig. 24- Sample list of logged source coverages

3.3.4.5 Include Processed Coverage (CtrI+G)

This option builds a composition from processed data including scanned chart coverages. Scanned
chart coverages are comprised of map data that have been scanned within MMC and compressed into
CAC segments, then logged and stored on hard disk or CD. The menu selection box provides four
columns of information for each entry: Info filename, Scanned Coverage filename, date scanned data
was logged into MMC, and a brief description of the geographic coverage of the data.

3.3.5 Preferences

The Preferences menu (Fig. 25) allows the user to set certain preferences for the current MMC
session, including whether to build an AOD or MPS composition, the primary source from which to view
CAC data in the current image (e.g., from CAC CD or from scanned data on the hard disk), and in what
format to display latitude and longitude coordinates, and print options. Some menu options are selectable
via toggle buttons that turn red when chosen.

Fig. 25 - Preferences menu

3.3.5.1 Compose AOD ICompose MPS

This option sets the type of image to be built. This preference may be changed at any time during the
creation of a map theater build. Note that restrictions on AOD images are more stringent than MPS
images:
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9 When switched to Composing AOD ON (default), MMC will design a composition based on the
restrictions of AOD images (e.g., MMC calculates the final image size, #directories per scale
and zone, #MB per directory). Note that MMC does not limit a user from exceeding AOD
restrictions (although it will issue warnings) until saving a final composition.

When switched to Composing MPS ON - by clicking on the Compose MPS option (Fig. 26) -
MMC will compose an image based on the restrictions of MPS images (e.g., image size). A
message box appears to confirm selection of this option. DTED data is only available when the
Compose MPS preference is on.

Fig. 26 Composing preferences

3.3.5.2 View CAC CDROM

This option sets the source from which to view chart data. MMC tailors the menu options
accommodate the specific data source. Figure 27 shows menu options for a CAC data source, and Fig. 28
shows menu options for an MPS data source. Chart data may be viewed by selecting a coverage area
with the arrow button, positioning the cursor in the area of interest, and pressing the third (right) mouse
button. (For more information on viewing chart data in MMC, see Section 4.3.) Chart data will only be
displayed for available CAC coverage in the source selected:

* View CAC CDROM: sets the preference to view CAC data from a CAC CD (available from
NIMA). When this preference is set, and the user clicks (with the third mouse button) on a
segment to be viewed, MMC will issue a message telling the user to load the necessary CD.
For more information on loading and reading CDs, see Section 4.1.

* View AOD: view CAC data from an AOD mounted in the DMU (Digital Memory Unit).
This option is not available until the user opens an AOD Image by clicking on File then
Open Image. This option is also not available if there is no DMU attached to the system.
(For more information on DMUs and DMUIs, see Appendix A.)

e View MPS Hard Disk: view map data from an MPS image stored on the hard disk.

* View MPS CDROM: view map data from an MPS image that has been logged and archived
to CD. When this preference is set, and the user clicks on a segment to be viewed, MMC will



24 Myrick el al.

notify the user to load the necessary CD. For more information on loading, selecting, and
reading CDs, see Section 4. 1.

"* View Processed Hard Disk: view processed map data stored on the hard disk.

"* View Processed CDROM: view processed map data that has been logged and archived to.
CDROM. When this preference is set, and the user clicks on a segment to be viewed, MMC
will notify the user to load the necessary CD (see Section 4.1).

" View Downsampled Data: view downsampled (i.e., intermediate) map data stored on the hard
disk.

Fig. 27- CAC source data preferences Fig. 28 - MPS source data preferences

3.3.5.3 View Latitude/Longitude Preferences

This option determines how MMC will display latitude and longitude coordinates: decimal degrees
[default] or degrees, minutes, and seconds (Fig. 29). The selection is made via toggle buttons that turn
red when chosen.

Latitude and longitude coordinates are used in the following MMC functions:

"* the Cursor Position box in the lower-right corner of the main MMC display (Section 3.2.7);

"* to define or erase coverages by latitude and longitude; and

"* to pick control points after scanning a chart.
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Fig. 29 - View latitude/longitude preferences

3.3.5.4 Print Preferences

This menu provides options for specifying the printer type and resolution (Fig. 30). The selection is
made via toggle buttons that turn red when chosen.

"* No Printer: indicates a printer is not available for use. This is the default setting (upon first
installing MMC 3.3).

"* Text Only Printer: indicates the available printer can only print text (e.g., the Okidata printer
provided with the original MOMS (Map, Operator, and Maintenance Stations) systems; for more
information on MOMS, see Appendix A).

" HP Text / Graphics Printer (300 DPI): indicates the available printer is a Hewlett Packard with
300 dpi resolution.

HP Text / Graphics Printer (600 DPI): indicates the available printer is a Hewlett Packard with
600 dpi resolution.

" Seiko Color Printer: indicates the available printer is a color Seiko such as those provided with
the original MOMS systems. - -
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"lA

Fig. 30 - Printer preferences

3.3.5.5 Display Preferences

This option sets the type of color map used for data display (Fig. 31). The selection is made via toggle
buttons that turn red when chosen.

" Use Reduced Colormap: This is the recommended setting for MMC. This option reduces the true
240-entry color palette to the number of colors allocated by X-Windows.

" Use Virtual Colormap (Cockpit View): This option allows additional colors that are not normally
required and is used in supporting cockpit views. It overrides the X-Windows color allocation
and assigns the true 240-entry color palette to the map data.

Fig. 31 - Display preferences

3.3.6 Tools

The Tools menu (Fig. 32) provides the user with an army of utilities, including logging in new media
(including CAC and DTED CDs), checking subdirectory size limits while designing a composition,
generating a summary of the current composition, building an AODI to hard disk or AOD, working with
checklists and other data frames, scanning paper charts into CAC for use in an AODI or MPS-CDI build,
and archiving data (including scanned data, AODIs, MPS-CDIs, and checklists) to CD.
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Fig. 32 -Tools menu

3.3.6.1 AOD (or MPS) Options

Depending on whether the user is composing an AOD image or MPS image (determined in the
Preferences Menu, Section 3.3.5.1), the first item in the Tools menu will be either AOD Options or MPS
Options. As shown in Fig. 33, there are six AOD options: Generate AOD Summary Build AOD Image
Generate Append Summary. Covp AOD Image to WORM, AOD Recycle, and Cop_ Checklist to WORM.
There is only one MPS option: Build MPS Image.

3.3.6.1.1 Generate AOD Summary - This option generates a printable summary of a previously
built AOD (Fig. 34), including current status, date of summary, number of superdirectories used and
remaining on the AOD, AOD size in bytes and number of subdirectories written on the AOD. The
summary also includes the names of the workstations used to create and write the AOD, AOD image
composition and version numbers, and date written. A contents section includes additional subdirectory
information, such as map scales and zones. The final coverage section provides the minimum and
maximum latitude and longitude values - for each subdirectory - which together define the complete area
of coverage.
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Fig. 34 -Sample AOD summary listing

3.3.6.1.2 Build AOD Image [or Build MPS Image] -This option builds a final image file from the
user's AOD or MPS composition. Note: if the user has set the Compose AOD preference (Section
3.3.5.1), MMC will automatically build an MPS image first, then the AOD image. If the user has set the
Compose MPS preference, MMC will only build the MPS image. The Build AOD [or MPS ] Image
option is not available until the user has opened a final composition (Section 3.3.1.3).

3.3.6.1.3 Generate Append Summary - This option generates a summary of any existing AOD
composition, composition in development, or final AOD image (Fig. 34). For each zone, scale, and
subdirectory in the composition or image file, AOD Summary provides the minimum and maximum
latitude and longitude, the number of CAC segments defined, and the number of sectors that would be
used if the image were written to an AOD. The summary also gives the total number of bytes in the
composition.
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3.3.6.1.4 Copy 40D Image to WORM - This option copies an AOD image from the MMC hard
disk to an AOD on the DMU. Follow the directions given by MMC for this function. When a blank
AOD is being used, MMC automatically begins the write procedure. If the AOD already contains data, it
may either be recycled (i.e., all previous data are lost) and written with the new image or the AOD can be
appended (with no loss of existing data). If the AOD contains data from a failed write operation, MMC
will offer to recycle it for use. Make sure an AOD is properly installed in the DMU, with the write-
protect tab in the up (T) position and that the DMU is turned on. Recommendation: label each AOD
with the serial numbers of both the DMU and DMUI used to write the AOD. If there have been three
write operations made to the AOD (i.e., the original write plus two appends), there should be three sets of
DMU and DMUI serial numbers on the label (some may be duplicates).

3.3.6.1.5 AOD Recycle - This option allows remaining space on a previously used AOD to be
utilized for new AOD images. Note: any pre-existing images on the AOD are lost during the recycle
operation. MMC invokes the AOD Recycling Window (Fig. 35).

Fig. 35 - AOD recycle menu with file options

Make sure an AOD is properly installed in the DMU, with the write-protect tab in the up (") position.
Make sure the DMU is turned on. In the AOD Recycling Window, click on the File menu option, then
Oen to allow the DMU to open and read the AOD. MMC will then notify the user that the last sector
written is being determined (this may take a few minutes to accomplish). Once completed, MMC displays
the amount of remaining available space on the AOD and whether the open operation was successful. If
the open was successful, the AOD may be recycled for further use.

To recycle an AOD, click on the AOD Recycling Window Tools menu, followed by the Recycle
option (Fig. 36). Since all pre-existing data will be lost, a confirmation window is provided. Click on No
to cancel recycling or Yes to continue. When the Yes option is selected, the AOD will be recycled, which
may take a few minutes to complete. Upon successful completion, a message will be displayed and the
AOD is now available for use. To return to the main MMC Window, click on the Close option that is
located under the File menu of the AOD Recycling Window.

BEST AVAILABLE COPY
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Fig. 36- AOD recycle option

3.3.6.1.6 Copy Checklist to WORM--This option copies an entire checklist set from the MMC hard
disk to an AOD on the DMU. Follow the directions given by MMC for this function. Make sure an
AOD is properly installed in the DMU, with the write-protect tab in the up (1') position. Make sure the
DMU is turned on. Recommendation: label each AOD with the serial numbers of both the DMU and
DMUI used to write the AOD. If there have been three write operations made to the AOD (i.e., the
original write plus two appends), there should be three sets of DMU and DMUI serial numbers on the
label (some may be duplicates).

3.3.6.2 CDROM Options

Includes archiving data to CD and restoring logged sources from CD (Fig. 37).

3.3.6.2.1 Archive Data To CDROM- This option "Premasters" a set of data into a CD image and
writes the data to a CD. The CD images conform to the International Standard Organization (ISO) 9660
standard for optical disk formats. When a user selects this option, MMC opens the Archive To CDROM
Window (Fig. 38). Click on Premaster and select the data type to be archived: Scanned CAC Data,
Aircraft Optical Data, Checklists/Dataframes Data, Mission Planning Data, Copy CDROM to CDROM,
Audit files, User Defined Templates, Scanned GeoTIF Files, or JMPS Coverage Files. MMC will build
an ISO 9660 Image from the selected data. If the user has built an ISO Image before, MMC will prompt
the user to delete that file before building a new one. After premastering the data into an ISO Image,
select Cut to actually copy the data to a CD. When finished, select Close to return to the main MMC
Window. The Archive options include:

1
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Fig. 37- CDROM options menu
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Fig, 38 - Archive to CDROM window

1) Scanned CAC Data: If the user is archiving scanned data, MMC will pop-up a list of valid chart
series to be archived (JNC, ONC, TPC, JOG, TLM-100, or TLM-50). Only one series of
scanned data may be archived to a single CD, to maintain compatibility -with the format and
structure of CAC CDs. The only difference between CAC and scanned chart (SCAC) CDs is in
the first field of their CD library numbers: tt-yyyy-e-MAPs-fnnnn, where:
ft = type of data: 'CD' for CAC, or 'SC' for SCAC;

yyyy = year (e.g., 1997);
e = edition (A through Z);
'MAP' = the characters "MAP";

s = scale (0 through 6; described in Appendix C.3);

f = a unique integer identifying the CD mastering facility (e.g., 0 = 3M);

nannn = a unique ID number (0000 through 9999).

MMC recognizes both CAC and SCAC CDs as valid sources, but the library numbers must be
different so that newly logged SCAC CDs will not erroneously replace previously logged CAC
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CDS, or vice versa. The 'CD' vs 'SC' at the start of the library number keeps the two data types
distinct.

2) Aircraft Optical Data: When archiving AOD data, MMC first checks whether there is a valid
AOD Image on the hard disk. If not, MMC will not allow the user to Premaster. If there is a
valid AOD Image, MMC will ask the user to verify the data to be archived. Select Yes to
proceed (or Abort to cancel the operation).

3) Checklist / Dataframes Data: Archives dataframes (e.g., checklists) to CD. MMC will issue a
verification message: select Yes to proceed (or Abort to cancel).

4) Mission Planning Data: When archiving MPS data, MMC first checks that there is a valid MPS
Image on the hard disk. If not, MMC will not allow the user to Premaster. If there is a valid
MPS Image, MMC will ask the user to verify the data to be archived. Select Yes to proceed (or
Abort to cancel).

5) Copy CDROM to CDROM: Use this option to make a duplicate copy of any CD. MMC will
display a verification message (answer "Yes" to proceed) then the CD-ROM Site Window.
Load the CD to be copied into the CD changer, then click on the Start Processing button at the
bottom of the CD-ROM Site Window. (See Section 4.1 for more information about loading and
selecting CDs in MMC.) MMC will take the user through the necessary steps to Premaster the
data. MMC prompts the user about deleting the preexisting data before deleting it.

6) Audit Files: Use this option to archive audit files that are generated during AOD build to WORM

operations.

7) User Defined Templates: Use this option to archive final compositions.

8) Scanned GeoTIF Files: Use this option to archive all GeoTIF files.

9) JMPS Coverage Files: Use this option to archive all JMPS coverages.

3.3.6.2.2 Restore Options - Restores previously logged sources from CD to hard drive (Fig. 39).

The following options are provided:

I) Restore Bitmaps to HD: Use this option to restore archived user-defined templates.

2) Restore AOD to HD: Use this option to restore an AOD image.

3) Restore Checklist / Dataframes to HD: Use this option to restore checklist sets.

3.3.6.2.3 Verify CDROM-Provides a summary of directories and data files stored on a CAC CD.
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Fig. 39- CDROM Restore options

3.3.6.3 Dataframe Management

Dataframe/Checklist management is facilitated through the use of two managers: the Category
Manager and the Page Manager, which provide the means to view, manage and edit checklist/dataframe
sets and their associated pages (Fig. 40). Categories within a set are viewed, managed and edited by the
Category Manager. Each category is sequentially numbered and listed by title (Fig. 41). The number
portion is a button that is used in conjunction with menu task buttons. The title portion is displayed in an
editable window (Fig. 42).

Radar Checklist Set

Categories are Pages within a category
managed and edited are managed by the

by the Dataframe Dataframe Page Manager
Category Manager and edited with the

Checklist Editor

Fig. 40- Example of a Radar Dataframe/Checklist set containing two categories
and four pages within each category
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Menu task ý _ ._

buttons

Datafrarne/ l
Checklist set
uatae

Category
information jr
(See Fig. 42)

Fig. 41 - Dataframe Category Manager

Category Title (editable)

Categouy Number

Fig. 42- Category Information within the Category Manager

Menu task buttons perform a variety of operations on the categories and the pages they contain,
including Copy, Paste, Undo, Add, and Delete. These operations are functionally similar to those used in
conventional software packages:

"* The Copy button makes a complete copy of the selected category and stores it in a copy buffer. To
make a copy, click on a category button, then, click on the copy button. For example, to make a
copy of category 10, click in the category 10 button and then click on the copy button.

" The Paste button places a copy of the selected category (made via the Copy button) at the
specified location. If the specified location is another category, it is replaced with the contents of
the copy buffer. Otherwise, the copy buffer contents are inserted at the specified location, which
could be at the first category location, or between existing categories, or at the last location. A
maximum of 16 categories are allowed. For example, if the area between category 6 and 7 is
selected, and the Paste button is clicked, the contents of the copy buffer are inserted between the
categories.

"* The Undo button reverses the last operation performed. For example, if the last operation was a
deletion, an Undo will restore the previously deleted category.

BEST AVAILABLE COPY
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" The Add button creates and inserts a new category at the specified location, which could be at the
first category location, or between existing category locations, or at the last location. A
maximum of 16 categories is allowed. When this number of categories exists, additional
categories are not allowed. Once created, the new category contains an empty title field and one
blank page. Double-clicking inside the text box and typing text adds a category title. NOTE: all
categories must possess titles to be considered valid. Double-clicking in the text box and
entering new text also modifies existing category titles. This button will initially be insensitive
until an area is selected (via mouse click).

" The Delete button removes a category from the set.

To begin using the Category Manager, click on File menu, then on the Open option to have MMC
provide a list of available checklist sets (Fig. 43). Select one of the available checklist sets by double-
clicking on the desired set. Then, the Dataframe Category Manager is updated showing available
categories for the selected checklist set.

Fig. 43- Dataframe/Checklist set selection

3.3.6.3.1 Drag-and-Drop Operations - Category placement is modified through drag-and-drop
operations. Perform a drag-and-drop operation by clicking on a category button using the second mouse
button. While still pressing the second mouse button, move the cursor to the desired location and then
release the mouse button. The desired location could be at the first category location, or between existing
category locations, or at the last location. For example, to switch the third and fourth categories, use the
second mouse button to click (and hold down) on category 3, and then drag it to the area after category 4.

3.3.6.3.2 Exit/Save As Operations -Use the File option to save edits. A popup window is provided
for naming the newly created checklist/dataframe set. The Save As option is only available if edits have
been made to the checklist/dataframe set.

3.3.6.3.3 Page Manager - Pages within a category are viewed, managed, and edited by the Page
Manager, which is invoked by double-clicking on the desired category button in the Category Manager
window. By default, the first page is selected. A selected page is identified with a shadowboxed button
and displayed in the centered view area. Figure 44 shows seven pages that are contained within the
ASYM category with the first page selected.
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Menu task buttons

Title of page
image displayed

Page image that
can be edited withl

the ChecklistEditor ,

Page information

Fig. 44-Page Manager

Each page is sequentially numbered and listed by title. The page number portion is a button that is
used in conjunction with task buttons and the title portion is displayed in an editable window (Fig. 45).
Also, note that this is a selected page since the page number button is shadowboxed.

YMTV R1,
Page number Page title (editable)

Fig. 45 - Page Information within the Page Manager

The Page Manager is similar in design and functionality to the Category Manager and also provides

Copy, Paste, Undo, Add, and Delete operations:

"* The Copy button makes a complete copy of the selected page and stores it in a copy buffer.

" The Paste button places a copy of the selected page (made via the Copy button) at the specified
location. If the specified location is another page, it is replaced with the contents of the copy
buffer. Otherwise, the copy buffer contents are inserted at the specified location, which could be
at the first page location, or between existing pages, or at the last location. A maximum of 16
pages per category are allowed.

"* The Undo button reverses the last operation performed. For example, if the last operation was a
deletion, an Undo will restore the previously deleted page.

"* The Add button creates and inserts a new blank page at the specified location, which could be at
the first category location, or between existing pages, or at the last location. This button will
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initially be insensitive until a location is selected (via mouse click). A maximum of 16 pages is
allowed. When this number of pages exists, additional pages are not allowed. Once created, the
new page title is blank and contains no data. The page is modified with the Checklist Editor
(Section 3.3.6.3.4). Double-clicking in the text box and entering text adds a page title. Note: all
pages must possess titles to be considered valid. Double-clicking in the text box and entering
new text also modifies existing page titles.

* The Delete button removes a page from the category.

* Page Drag-and-Drop Operations: Page placement is modified through drag-and-drop operations.
Perform a drag-and-drop operation by clicking on a category button using the second mouse
button. While still holding down the second mouse button, move the cursor over to the desired
location and then release the mouse button. The desired location could be at the first page

Slocation, or between existing pages, or at the last location. For example, to switch the third and
fourth pages, use the second mouse button to click (and hold down) on page 3, and then drag it to
the area after page 4.

Accept and Cancel Operations: The Accept and Cancel buttons are located at the bottom center
of the Page Manager window and are used to exit the Page Manager. Click on the Accept button
to save edits, or click on the Cancel button to cancel and lose all edits. All of the original pages
remain unchanged when the cancel button is used

3.3.6.3.4 Checklist Editor -- Use the Checklist Editor to edit a page image. Select the desired page
by clicking on the appropriate page button within the Page Manager, then double-clicking on its image.
MMC will display the Checklist Editor Window (Fig. 46) to help the user build and modify AV-8B
checklists that can be displayed in the cockpit moving-map system. Editor functions include changing
text color (Led, Green, or Amber) and font size (Small, Medium, or Lar•ge). A future version may support
both Insert and Overstrike edit modes, but currently only Overstrike is available.
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Fig. 46 - Checklist Editor window,

To set text color, click on the Red Green or Amber button, then click in the text area at the desired
starting point, and type. All new text will be in the selected color.

To change text color, first click on the Red, Green, or Amber button, then click on the character to be
changed. For example, click on Amber then click on a character to be changed (in Fig. 47, the user
changed the selected character from red to amber). Type over any additional characters (immediately
following the first) to change them to amber. Any other characters (not immediately following the first)
must be changed by clicking again on Ambr, then clicking on the new character. Future updates to
MMC could support more user-friendly color changing.
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Fig. 47-Example of changing text color in MMC Checklist Editor: (a) click on new color (c.g.. amber) then
(b) click on letter to change (e.g., from red)

BEST AVAILABLE COPY
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To change font size, first click on the Small, Medium or Large button, then click anywhere in the line
to be changed. For example, click on Lge then click on a line to be changed (in Fig. 48, the font size
of the selected line is changed from small to large). Font size can only be changed an entire line at a
time.

(a)

File Options s i " .h.l .E ( l o n

then T (b)Tli i h -- Ai "REIRED

(ao)

Fig. 48 -- Example of changing font size in MMC Checklist Editor: (a) click on new size (e.g., large)
then (b) click in line to change (e.g,, from small)
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Currently, MMC only supports Overstrike mode in the Checklist Editor. A future update could
support Insert mode.

The following special characters are available for use:

D Right-handed footnote (overstrike allowed). Type the ">" character and
place the cursor inside the symbol to insert text.

D Right-handed footnote (overstrike NOT allowed). Type the">!" characters.

a Left-handed footnote (overstrike allowed). Type the "<" character and
place the cursor inside the symbol to insert text.

a Left-handed footnote (overstrike NOT allowed). Type the "<@" characters.

Use the "@" or "!" characters to enter blank spaces with no overstrike capabilities.

To close an edit session without saving any edits, click on Close under the File menu. To save an
edited checklist set (and keep the same name), click on Yes at the save edits prompt.

3.3.6.4 Media Options

This option includes logging and unlogging media (e.g., CAC or DTED data from NIMA) in the
MMC source databases (Fig. 49):

3.3.6.4.1 Log Media - Logs new source data (CAC or DTED from NIMA) in the MMC source
databases. While logging in a new CAC or DTED CD, MMC will build a bitmap of the source data that
will be used to calculate and overlay available coverages (Section 3.3.3.6) and incorporate logged source
data (Section 3.3.4.4) into an AODI or MPS-CDI. When the user selects Log Media, MMC pops up the
CD-ROM Site Window. After entering all the CDs to be logged, click on the Start Processing button at
the bottom of the window (Section 4.1).

Note: DO NOT eject any CDs until the "Logging Complete" message is displayed!!

3.3.6.4.2 Unlog Media - Removes references to source data from the MMC log file. This is done if
a previously logged source is found to be bad (e.g., an unreadable CD). Note: MMC will store multiple
CAC CD versions, but not multiple DTED versions, because NIMA provides unique edition numbers for
CAC CDs, but not for DTED CDs. (A future version of MMC may provide a work-around to this
problem). Therefore, whenever NIMA issues a new version of a DTED CD, the user must unlog the
previously logged version before logging the new one.
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Fig. 49-Media options

3.3.6.5 Scan

This option includes scanning paper charts into CAC (including all phases of compression) and
deleting scanned data from MMC. It also facilitates the inclusion of new and updated charts (that are not
yet available in digital form) to be included in an AODI or MPS Image. The scanning process is
comprised of nine steps:

1) Scan the chart;
2) Save an acceptable scan;
3) Identify the chart datum and ellipsoid;
4) Enter control points;
5) View and accept the control points;
6) Clip the image (if desired);
7) Scan another chart (if desired);
8) Quit scanning and finalize data;
9) Review scanned data.

These steps are detailed in the following sections.

Step 1: Scan the chart'

Select a chart to be scanned then position the chart on the scanner. From the MMC Window, under
the Tools menu, click on Scan and MMC will display the Scan Overview Window (Fig. 50).

If there are scanned files already on the hard drive, a dialog message will appear before the Scan
Overview Window is displayed, stating that if those files have already been processed into CAC they
should be deleted before starting a new scan. Select one of the following options: 1) Scan More/Add to
Exis to append the new scan to the scanned files on the hard drive, 2) Delete Files/Scan New Area to
delete the previously scanned files (click Delete GeoTIF Area in the dialog following to confirm), or 3)
Cancel Scannin.

Under the File menu of the Scan Overview Window, click on Start Scan to begin the scan. MMC
will display the scan as it progresses (Fig. 51). A full scan (i.e., 11" x 16" section of chart) takes about 3
minutes to complete. At any time during the scan, the user can click on Cancel at the top of the Scan
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Overview Window (e.g., if the chart is upside-down or sideways, or if the wrong chart is in the scanner).
MMC will discard any scanned data from the current scan and let the user start over.

Fig. 50- Scan Overview Window Fig. 51 -- Scan in progress

Step 2: Save an acceptable scan

After the scan is complete, MMC will ask if the scan should be saved. Click on Yes if the scan is
acceptable. Otherwise, click No. Make necessary adjustments and rescan the chart.

Step 3: Identify the chart datum and ellipsoid

When an acceptable scan is obtained (i.e., Yes was clicked in the preceding step), the GeoTIF
Registration Tool (Fig. 52) will automatically pop up and display the scan.

The GeoTIF Registration Tool's Preferences menu (Fig. 53) provides options for setting the format
for latitude and longitude coordinate entry and the datum type. The Enter Latitude and Longitude as
option allows the user to set coordinate entry in one of the following formats: Decimal Degrees; Degrees,
Minutes and Seconds; or MGRS.

Use the Datum option (Fig. 54) to select the appropriate datum for the scanned chart. Table 2 lists all
the supported datum and ellipsoids in MMC. Select the correct datum from the menu (datum and
ellipsoid information is usually printed in one of the chart's margins); the selected datum is shown by a
red dot next to the datum in the menu (as seen in Fig. 54).

BEST AVAILABLE COPY
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Fig. 52- GeoTIF registration too]

Fig. 53 - GeoTIF lat/lon control point preference

Fig. 54- GcoTIF datum menu with WGS84 selected
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Table 2 - List of Datums and Ellipsoids Supported by MMC

Datum and Ellipsoid Names
WGS84 Kertau 1948 (Malayan revised)
WGS72 LIB
ADI-S LUZ-S
ARF-M Liberia 1964
AUG Luzon
Adindan MER
Airy Ellipsoid MIN-B
Arc 1950 Merchich
Australian Geodetic 1984 Modified Airy Ellipsoid
Australian National Ellipsoid Modified Everest Ellipsoid
BAT Montjong Lowe
BUR NAS-C
Bessel Ellipsoid NAS-S
Bukit Rimpah Nigeria (Minna)
CAI North American 1927 (Alaska and Canada)
CAZ North American 1927 (CONUS)
CHU OGB-M
COA OHW-K
Camp Area Astro OHW-M
Clarke 1886 Ellipsoid OHW-O
Clarke 1880 Ellipsoid Old Hawaiian, Kauai
Djakarta (Batavia) Old Hawaiian, Maui
EUR-M Old Hawaiian, Oahu
European 1950 Ordnance Survey of Great Britain (1936)
Everest Ellipsoid QUO
G. Serindung Qornoq
GEO SAM-P
GSE Sierra Leone 1960
GUA South American (Campo Inchauspe)
Geodetic Datum 1949 South American (Chua Astro)
Ghana South American (Corrego Alegre)
Guam 1963 South American (Provisional 1956)
Gunung Segara - - South American (Yacare)
HEN Special Datum, Indian Special
HIO Special Datum, Luzon Special
HTN Special Datum, Tokyo Special
Herat North Special Datum, WGS84 Special
Hjorsey 1955 TANTAN
Hu-Tzu-Shan TIL-B
IND-S TOY-S
IRL Tananarive Observatory 1925
Indian Timbalai
International Ellipsoid Tokyo
Ireland 1965 Voirol
KEA YAC
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Step 4: Enter control points

Enter a set of control points to accurately georeference the scanned image (i.e., reference each pixel to.
a latitude / longitude coordinate). If control points are not entered correctly, the resulting image could
look warped, inverted, or otherwise corrupted (Fig. 55).

Fig. 55 - Example of scanned chart that was improperly georeferenced

Use the scroll bars at the right and bottom of the GeoTIF Registration Tool to scroll through -the
image and find appropriate control points (e.g., intersections of latitude and longitude lines). Then, click
on the image at the control point location and the Control Point Entry Window (Fig. 56) will appear.
To pick a control point, first click with the left (first) mouse button on a point within the scanned image.

MMC will display a Control Point Entry Window with a zoomed-in view of this point and its
immediate surrounding area to allow the user pick the point more accurately (Fig. 56). In this window,
click on the selected point as accurately as possible, then enter the latitude and longitude values for this
point. To reenter these values, click on Clear and reenter them. Note: if MGRS is the preferred control
point format (in step 3), enter the control points in MGRS units, not in latitude and longitude as shown in
Fig. 56.
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Fig. 56-- Control Point Entry Window, including zoomed-in area surrounding the point, plus entry boxes for graphic
coordinates (here in degrees, minutes, and seconds format)

Click on Acep when the control point is acceptable or click on Cancel and pick the point again.

Repeat this process for each selected control point. Pick a minimum of 3 for nonpolar charts (6 for
polar) and a maximum of 25 control points. Ideally, for nonpolar charts, the user should pick at least the
4 corner points of the scanned image (or points close to the 4 corners) to get an accurate georeference.
For polar charts, also select several control points within the chart.

Step 5: View and accept control points

After selecting all necessary control points, choose the View/Acceot Control Points option from the
GeoTIF Registration Tool's Tools menu to display the Selected Control Points window, which lists all
the selected control points and allows the user to edit or delete them, if necessary (Fig. 57).
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Fig. 57- List of selected control points

To edit a control point, click once on the point to select it, and then click on the Edit button. The point
coordinates will appear in the boxes in the lower half of the Selected Control Points window and will be
available for editing. Make any changes to the points in the boxes, and then click the Accept Edits
button. Repeat for any control points that need editing.

When satisfied with the list of control points, click on Accept Control Points. MMC now will
transform the control points from the scanned chart's source datum and ellipsoid to the selected datum.
After a few seconds, MMC will display a template-representation of the scan zoomed into the sdanned
area, with a composition of the scanned image overlaid by a latitude and longitude reference grid. MMC
will also display a message asking if the scanned coverage is in the right area (Fig. 58); i.e., is it in the
right location and of the right size and shape? The user may have to move this message to the side if it
obscures the template.
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Fig. 58-•Composition of newly scanned chart data and verification that it is correct

Not.._e: if the image was clipped, MMC will have clipped it to the nearest TS segment boundary, to
keep the entire segment intact. Therefore, the template boundaries may not exactly match the user-
entered clip bounds (the template may be slightly larger).

If the template does not look right, click No to the message. MMC will let the user edit the list of
control points again or start the scan over. If the template is acceptable, click Yes. Note: the data will be
subsampled into TS segments, but are not yet color-compressed. A dialog appears asking whether the
scan is to be clipped. Click Ye._s to clip the scan or No to return to the Scan Overview Window.-

Step 6: Clip the image (if desired)

When an acceptable set of control points is obtained, the user is asked if the scanned image needs to
be clipped. If so, click Ye.._s to invoke the GeoTIF Clipping Tool (Fig. 59) and display the scanned image.
Use the slide bars located at the top and left of this window to set the horizontal and vertical clip margins.
For example, to clip the left margin of the scan, slide the top slide bar horizontally until the red line is
positioned on the boundary of the desired clip area. Then, double click on the top slide bar, and the user
will be asked whether to clip to the Left or Right side of the red line. If Lefft is selected, everything to the
left of the red line will be clipped (Fig. 60). The left slide bar works vertically for setting the top and
bottom clip margins.
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Fig. 59- GeoTIF Clipping Tool Window Fig. 60- Scanned data after clipping

There are two clipping tools available for use: the polygon vertices tool and the stretch-box tool. Both
tools are located near the bottom left comer of the window. They provide the means to clip the scanned
image using boxes and polygons, and are functionally identical to their counterparts found in the main
MMC window.

The Polypon Vertices button defines an irregularly shaped area. Click on this button,
and then click on a set of points on the scanned image with the left (first) mouse button.
The points will define the vertices of a polygon, which in turn defines the area to be
clipped. To close the polygon, double-click with the left mouse button. The area inside
the polygon will be clipped.

The Stretch-Box button defines a rectangular clip area using a "rubber-band" box. Click
on this button, and then click on the upper-left comer of the area to be clipped with the
left (first) mouse button. Hold the mouse button down and drag the resulting stretch-box
to encompass the desired area. Note: the rubber banding-only works from upper-left to
lower right! As long as the mouse button is held down, the stretch-box will be
adjustable. When the box is satisfactory, release the mouse button. Click once more
with the left mouse button to accept the area, and the area inside the rectangle will be
clipped.

The Edit menu provides options to reverse clippings (Fig. 61). The Undo option reverses clip
operations one step at a time whereas the Revert Back to Original Image option removes all clipping
operations at once and restores the original unclipped image.
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Fig. 61 -- GeoTIF Clipping Tool edit menu

Save the clipped image by clicking on the File menu, then on the Save ClizrninR option (Fig. 62).
Select the Exit option to close the GeoTIF Clipping Tool and continue. If the image has not been saved,
a dialog appears noting that any clipping done will be lost at the exit. To continue the exit without saving
the image, select the Exit Clipping Tool option. To abort the exit, select Cancel Exit. After either of these
options is selected (Save Clippin or it), the GeoTIF Clipping Tool is closed and replaced with the
Scan Overview Window.

Fig. 62- GeoTIF clipping file menu

Step 7: Scan another chart (if desired)

To scan another chart of the same scale (or an adjacent section of the same chart), reposition the chart
on the scanner and repeat the steps, starting with Start Scan in the Scan Overview Window (step 1). To
scan another chart of a different scale, quit this scan session first and then start a new scanning session
(with step 1) for the new scale. Note: Before scanning charts of a new scale, compress and finalize the
scanned data for charts of the previous scale (see Data Processing, Section 3.3.6.7).

Step 8: Quit scanning and finalize data

If there are no more charts to scan in this scale, select Exit. The Exit option can be used at any time to
stop scanning and return to the main MMC Window. At this point, the Tools menu Data Processing
option (Section 3.3.6.7) may be used to compress the scanned data now or, compression may be
postponed for later.

Step 9: Review scanned data

After returning to the main MMC Window, the just-scanned data can be reviewed through the Tools
menu GeoTIF Utilities option (Section 3.3.6.6).
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3.3.6.6 GeoTIF Utilities

To review the just-scanned data through the GeoTIF Utilities option (Fig. 63), select the Previewer
option to invoke the GeoTIF Previewer (Fig. 64). In the GeoTIF Previewer window, click on File
menu and then the Preview option to open the image that was just scanned.

Fig. 63- GeoT fIF Utilities menu

Fig. 64- GeoTIF Previewer
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3.3.6.6.1 Previewer -- The GeoTIF Previewer depicts adjacent scanned charts being reviewed (see
Section 4.3 for more information on reviewing chart data in MMC). The GeoTIF Previewer provides
two menu options, including:

* Fike which provides options for previewing data (Preview), clipping information, scanned file
names, and properties (get Info), and Exit; and
T l which provides options for deleting scanned image files (Delete Image) and for exporting

the image to the clipping tool (Export Image to Clipping Too!).

First click on the image inside the Previewer window to select the options in either menu (such as Get
Lnfiz Delete Image or Export Image to Cliping Too!). The image will turn red, indicating that it has been
selected, and the following menu options will become available for use:

"* Get Info invokes a popup window that shows properties of the current scanned image (such as the
file name).

"* Delete Imagee deletes the selected scan file(s) from the hard drive. This option invokes dialog that
will verify file deletion with the options Delete and Exit Previewer and Cancel (which simply
dismisses the dialog).

"* Export Image to Clippinsz Tool invokes a dialog that will verify clipping the image. In this dialog,
click the Export to Clipping Tool option to clip the image more, or click Cancel.

3.3.6.6.2 Show GeoTIF Coverage -- Select this option to view areas of available coverages. Then,
click on the appropriate chart scale. After a few seconds, MMC will display a template representation of
the area of coverage, with a composition of the GeoTIF data overlaid by a latitude and longitude
reference grid. MMC will also display a message asking if the GeoTIF coverage is in the right area (Fig.
58); i.e., is it in the right location and of the right size and shape? The user may have to move this
message to the side if it obscures the template.

Note: if the image was clipped, MMC will have clipped it to the nearest TS segment boundary, to
keep the entire segment intact. Therefore, the template boundaries may not exactly match the user-
entered clip bounds (the template may be slightly larger).

If the template does not look right, click No to the message and return MMC to the main window. This
image must be rescanned and new control points selected.

If the template looks good, click Yes. MMC will return to the Main MMC Window.

3.3.6.7 Data Processing

This menu (Fig. 65) provides options for processing GeoTIF files to CAC and for finalizing
intermediate data.
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Fig. 65 - Data processing menu

3.3.6.7.1 CAC Processing -When the user selects the CAC option, MMC will process GeoTIF files
from scanning, or those stored on either hard disk or CD into CAC. First, a menu for selecting a chart
scale is provided. Click on the appropriate scale. A message window will appear noting that pre-existing
CAC data on the hard drive must be archived and deleted prior to processing since it will be lost (MMC
will automatically perform these functions).

Next, the CD-ROM Site Window (Fig. 66) appears, showing available data sources. Click on the
scanner button to indicate the source as hard drive (i.e., for scanned data) or click on the appropriate CD-
ROM device.
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Fig. 66 - CDROM Site Window with scanner button option

After the source has been specified, click on Start Processing to begin processing and invoke the
GeoTIF Processing Window (Fig. 67). By accepting the default settings, the GeoTIF data will be
downsampled and compressed into CAC. To view the downsampled data prior to compression, uncheck
the boxes that read Finalize Automatically and Optimization (see below). Since data downsampling may
take a while to complete, a Percent Completion Box is used to show the task progression. Wait until
processing has finished before trying to do anything else in MMC!

The GeoTIF Processing Window also provides an Advanced Processing Option for setting
processing optimization. This option sets processing optimization that determines when downsampled
data is compressed. When it is desirable to view downsampled data prior to compression, turn the
Optimization option off. This option is used to conserve disk space and should not be modified for
normal processing.



MMC Version 3.5 Software Users' Manual 57

Fig. 67-• GeoTIF Processing window

3.3.6. 7.2 Finalize Intermediate Files - When the user selects Finalize, MMC will compress all the
intermediate scanned data into "Scanned CAC" (SCAC) files. First, a cascade menu for selecting the
chart scale is provided. Click on the appropriate scale.

MMC will display a template representation of the data zoomed into the area of coverage, with an
overlay of a latitude and longitude reference grid. MMC will also display a message asking if the
coverage area is in the right area (Fig. 58); i.e., is it in the right location and of the right size and shape?
The user may have to move this message to the side if it obscures the template. If the template does not
look right, click No to the message and determine the cause of the discrepancy. Otherwise, click Ye__s and
MMC will invoke the GeoTIF Processing Window (Fig. 67). Accept the default setting to finalizing the
data. MMC will display a meter showing the percent. Wait until processing has finished before trying to
do anything else in MMC!

Not__.e: if MMC dies (e.g., due to a power failure) while compressing scanned data, simply restart MMC
and click on Tools, Sca._nn. Choose the chart series of the scanned data that was being compressed. MMC
will bring up the Scanning Tips Window (click on Begin with [ chart series ]), then the Scan Overview
Window. Click on Fil__e, then Exi_.t, and then continue with Finalize Scanned Data as previously
described.

When processing has completed, MMC will display a message saying that scanned data has been
added or removed at the current scale. Click Acknowledge. MMC will return to the main MMC
Window.

• ' " ' | i a i l i I I I I
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3.3.6.8 AV-JMPS Export

This menu option creates AV-JMPS templates (Fig. 68). First, MMC will display the outline of
coverages from the template (Fig. 69). The user may change map scales to view the outlines at other
scales. No other action is allowed within MMC once the exporter has been invoked. The files are written
to MMC_-SYSTEM :[BITMAPS.JMPSI. Next, under the File menu, click New (the user may then
perform any other actions in MMC).

When the user wants to write the coverage to CD-ROM to transfer to PFPS (Portable Flight Planning
System), under the Tools menu select CDROM Options, then Archive Data to CDROM. From the
Archive to CDROM Window select Premaster, then choose JMPS Coverage Files. Once the premaster
is complete, select Cut... from the Archive to CDROM Window (under the File menu).

After the CD-ROM has been written, it may be transferred to a PC. Follow the directions given in the
"Falconview Drawing File Format Interface Control Document" dated 15 May 2000 to import the AV-
JMPS files into an MS Access drawing file format. The AV-JMPS files may be imported into MS
Access as standard comma-delimited, ASCII files.

The AV-JMPS templates are ASCII files. The naming convention is the 10-letter template
identification name, followed by a '-" character, and the numeric scale (where 0 = TLM-50... 5 = JNC).
For example, AVJMPSI_-3.TXT, which is a template named AVJMPS I at map scale 3 (TPC). An AV-
JMPS template is built for each map scale. These files support the format specified in the "Falconview
Drawing File Format Interface Control Document" for Falconview 3.1.1.

"* :l4' .2 2 45P
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Fig. 68- AV-JMPS Option Fig. 69- Outline of template coverage

3.3.7 System

This menu (Fig. 70) includes options for maintaining system file resources including file deletion and

disk space utilization:

* Delete MPS Area: Clears an MPS area on the hard disk.

* Delete AOD Area: Clears an AOD area on the hard disk.

* Delete ISO Area: Clears an ISO area on the hard disk.
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"* Delete GeoTIFArea: Clears the scanned GeoTIF area on the hard disk.

"* Delete Checklist/Dataframe Set: Clears an entire Checklist set on the hard disk. MMC prompts
the user to select the set to be deleted.

"* Delete JMPS Coverage Files: Clears a JMPS area on the hard disk.

"* Delete Audit Files: Clears the Audit area on the hard disk.

"* Delete Processed Data: Clears the defined area of CAC data coverage for the specified chart
scale on the hard disk (Fig. 71).

"* Disk Usage: Invokes the Disk Utilization Window (Fig. 72), which graphically depicts the
percentages of used and available disk space.

-
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Fig. 70 S System menu
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Fig. 71 - Delete processed data option
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Fig. 72 System disk usage

3.3.8 Windows

The Windows menu (Fig. 73) executes various MMC utilities in pop-up windows, including
Composition Data Size, AOD/MPS Area Status, Data Sources, and History.
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Si .

Fig. 73- Windows Menu

3.3.8.1 Composition Data Size Display (Fl1)

Monitors how much disk space is used for each scale of chart data in a composition (Fig. 74). If one
or more scales have too much data (calculated by the number of AOD sectors permitted per scale), the
graph will turn red for that scale (Fig. 75(a)). If the size of the composition (for all the scales combined)
is greater than 260 MB - i.e., too large to fit on an AOD - then the "Total" graphs will turn red. This can
happen even if each individual scale of data is within the size limits of an AOD (Fig. 75(b)).

F Ii l

3.3.8.1g Copoito Doaostao Size Distha liits

Moitr ho muhdspc sue orec clfcatdt in cmoiio (ig 74) If one
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-_._----Number of Megabytes: LTotal %

TLM TCM JOG TPC ONC JNC DTED Total
,260v

0o 0 3590 .0 0 35 3

(a)

_ Number of Megabytes: --Total %

TIM 1CM JOG TPC ONC JNC OTED' Total
260

0- 0 0 133 70 0 138 0 341 131

Calculate % Us ed osel __

Fig. 75 -Composition data sizc exceeds AOD limit: (a) JOG scale exceeds 260 MB; (b) individual
JOG, TPC, and JNC scales are within 260 MB. but total exceeds 260 MB

3.3.8.2 AOD /INMPS Area Status (F12)

Lists iilI AODIs and MPS Images currently stored on the MMC hard disk (Fig. 76). The list includes
the descriptive title, library number, and build status for each image. Click on Acknowledge to erase this
display and return to the main MMC Window.
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AOD Area:
(NO AOD Image on the Hard Drive)

MPS Area:
PAKISTAN MPS-1995-001-0000043 (Build Comiplete)

!AcknowledgeJ

Fig. 76 AOD/MPS area status

3.3.8.3 Data Sources Display (Ctrl+4)

Lists all logged data sources for the current composition, including DTED (for MPS compositions
only), CAC and scanned chart data (Fig. 77). As the user defines new coverages, this display will reflect
any new logged sources that are applicable.

!CD- 1993-'.A- MAP2-O0024
'CD-1993-A-MAP2-00022
CD-1992-A-MAP2-00009
CD- 1991-A' MA P2-1i0007

Close P

Fig. 77-- Data sources display

3.3.8.4 The History Display (Ctrl+5)

Displays the MMC log-file (Fig. 78), which includes all errors, warnings, and other messages issued
by MMC. To print this log file, go to the MMC Print menu and click on Print MMC Log File (Section
3.3.9.3).
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Fig. 78-- MMC processing history log file

3.3.9 Print

The Print menu (Fig. 79) provides three options: print the entire screen, print AOD audit files, and
print the MMC log file.

3.3.9.1 Print Screen (1F2)

Prints the contents of the entire screen. Must have a graphics printer (i.e., HP-300, HP-600 or Seiko
prne)connected and set via Print Options (Section 3.3.5.4) under the Preferences menu.

3.3.9.2 Print AOD Audit Files (F7)

Prints the AOD Audit Files, which are created during AOD builds. After clicking on this option,
MMC will prompt the user for AOD serial number and side. Only the audit file for that AOD and side
will be printed. Must have a text printer (i.e., Text-Only Printer, HP -300, or HP-600) connected and set
via Print Options.

3.3.9.3 Print MMC Log File (F8)

Prints the MMC log file. The user is advised to view this log file first - via the History Display
(Section 3.3.7.5) under Windows - before printing. After printing, MMC will automatically purge the log
file (i.e., clear all contents).

Fig. 79- Print menu
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4. COMMON MMC OPERATIONS

4.1 Loading and Selecting CDs in MMC

MMC uses the CD changer for a variety of operations, including archiving scanned data, viewing
chart data, etc. The procedure for loading and selecting a CD is the same regardless of the application:

1) Load the required CD(s) in one of the 6 slots of the CD changer or in the internal CD drive. For
certain functions (e.g., viewing CAC data from CD), MMC will specify which CD to load.

2) MMC will pop up the CD-ROM Site Window (Fig. 80) listing all 7 CD slots, including 6 in the
CD changer (CDROMI through CDROM6) and the Alpha's internal CD drive (CDROM7).

Fig. 80- CDROM Site Window

3) Click (with left mouse button) on the CD device number(s) to be selected (1 through 7). As the user
selects a device number, MMC will enter it in the list (Fig. 81).

4) Select Scan Readers (in the lower-left comer of the window); MMC will list the titles of the CDs on
the selected readers (Fig. 82).
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CýD 1995 C- MAP3 00001

MD-1 992-A--MAP3--00014

CD-1992-A-MAP3-00011

Fig. 81 -CD-ROM Site Window: three CD readers Fig. 82- CD-ROM Site Window: titles listed for selected
selected (#2,3,4) CD readers

5) If any of the listed CDs is not required, click (with middle mouse button) and drag that CD's number
from the list to the Trash Can at the bottom of the window. Any CDs that were listed below the deleted
CD will be bumped up to fill in the list (Fig. 83).

!NFi N M.. ,.
1 C 195C.MP3-00001 V C-1 992-A-MAP3-00:i

~C 192A AP3-004C-95CMP-00

------ l l

Fig. 83 - CD-ROM Site Window: deleted one CD reader Fig. 84 -CD-ROM Site Window: switched priority of
from the list (#3) CD readcrs #2 and #4

6) The user can rearrange the order of the CDs in the list, if necessary. For example, when listing

source CDs to be used in building an AODI, the order will dictate priority: the CD listed first gets top
priority. This allows the user to properly overlap CAC sources with different edition numbers, since
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more recent data should get higher priority than older data. To reorder the CD list, click (with middle
mouse button) and drag the desired CD number to its new location (Fig. 84).

7) When all required CDs are listed in the appropriate priority order, select Start Processing (at the
bottom of the window).

8) Alternatively, select Clear Readers to start the process over, or Cancel to cancel the operation and
return to MMC.

4.2 Logging CAC, Scanned CAC, and DTED CDs

Prior to building any AOD or MPS compositions, the user must first log all the necessary NIMA data
sources. As a standard practice, NRL recommends that the user log-in every available data source as it is
received from NIMA. Figure 85 is a dataflow diagram that illustrates how to log data sources at various
stages of MMC processing.

Functional Diagram: Composition - Log Sources

comrositon No rcI

develpmnent. Dredr

c~o oreadr

Fig. 85- Logging data sources: complete before building any compositions

To log source data, perform the following steps:

* Insert the required CD(s) in empty slots of the CD changer caddy, then load the caddy in the CD
changer. Note: load each CD facedown in a caddy tray.

* Click on •gk then Media Options, then Log Media.

Yes •i IiI I
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MMC will pop up the CD-ROM Site Window (Fig. 80). Currently, MMC will only allow a user
to log in one CD at a time, so select the first CD reader containing a CD to be logged, click on
Scan Readers, then Start Processing. MMC may prompt for a descriptive title for each CD (e.g.,
"Continental US at TPC scale"). Logging one CD takes about 1 minute.

* After the first CD is logged, repeat the process for the second CD.

* For more information about loading and selecting CDs in MMC, refer to Section 4.1.

4.3 Viewing Chart Data

4.3.1 Viewing Chart Data from an AOD

This section lists the steps for viewing chart data written on an AOD.

1) Make sure the DMU power is off before loading an AOD (use the power switch on front).

2) Load an AOD containing chart data in the DMU.

3) Turn the DMU back on.

4) Wait 30 seconds after loading the AOD in the DMU before continuing.

5) Load the AOD image into MMC: In MMC: click on File, then Open Image (Section 3.3.1.4).
Follow the directions to open an AOD Image from the DMU and display the composition in the
MMC Window (Fig. 16).

6) Zoom into an area of interest with the Stretch-box Zoom button (Section 3.2.4.1).

7) View the chart data in the AOD image:

"* Click on an area of interest with the right (third) mouse button. MMC will pop up a Map
Coverage Window displaying chart data centered on the selected point.

"* To scroll around the image, position the cursor at the edge of the Map Coverage Window
and click with the left mouse button. For example, to scroll up, position the cursor at the
top edge of the window and click. (When switching TS zones, there will be a pause while
the new color palette loads).

"* From the Map Coverage Window (which displays the chart data), click on File, then Close
to return to MMC.

"* In MMC, click on Windows, then Composition Data Size Display to show which other map
scales (and how much data) are included in this image (Section 3.3.8.1).

"* Switch to one of the other scales of data (e.g., JOG or JNC) by clicking on the Chart Series /
Map Scale box in the lower-right comer of the MMC display (Section 3.2.6).

"* View the new scale of CAC data in the image; scroll around this new image.

4.3.2 Viewing Chart Data from a CAC CD

This section lists the steps for viewing chart data from a source CAC CD.

1) Log the desired CAC CD into MMC, if not already done (Section 4.2).

2) Click on the Coverages menu then on Include Logged Source Coverage (Section 3.3.4).

3) Click on the Preferences menu then on View CAC CDROM(Section 3.3.5.2).
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4) Click inside the coverage area with the right (third) mouse button.

5) MMC will prompt the user to load the appropriate CAC CD (Fig. 86); load it into the CD changer
caddy (Section 4.1).

6) After selecting the CAC CD in the CD-ROM Site Window (Fig. 80), click on Scan Readers, then
Start Processing. MMC will display the CAC data, centered on the selected point (step 4, above).

7) To scroll around the image, position the cursor at the edge of the View Data Window and click
with the left mouse button. For example, to scroll up, position the cursor at the top edge of the
View Data Window and click. (When switching TS zones, there will be a pause while the new
color palette loads).

8) From the Map Coverage Window (which displays the CAC data), click on File, then Close to
return to MMC.

Please load the on q CDPRo0:
CD-1995-C-HA"P3-00001

okay] Cance Helj

Fig. 86 - MMC prompt to load CAC CD

4.4 Design, Build, and Archive a New AODI and MPS-CDI

This section itemizes how to design, build, and archive a new AODI and MPS-CDI. To use this as a
tutorial, use the sample data sources provided to design the sample composition described. All tutorial
samples are given in { }.

1. Log in any data sources ( two CAC CDs of TPC (1:500k) series: CD-1995-C-MAP3-1000] and CD-
1996-B-MAP3-2003 ) needed to build the images (see Section 4.2).

2. Display all available coverages:

* Click on File, then New. The default chart series is TPC.

"* Zoom into an area of interest ( Hawaii and SW California ) (Section 3.2.4.1).

"* Click on Overlays, then Available Coverage (Section 3.3.3.6).
"* MMC will display the coverage of all data that has been logged, to date, at the selected scale.

3. Design a composition { Hawaii and China Lake, CA, in the TPC series }:

* Use the coverage definition buttons (Section 3.2.3) to define two areas of coverage { "Big Island"
of Hawaii and China Lake, CA, areas ).

* MMC will display each coverage area as a template comprised of colored boxes; the color
reflects the TS zone of the data, and the boxes represent TS segments. See Appendix C2 for
more information about TS.

* Use the Windows menu Composition Data Size Displa option (Section 3.3.8.1) to monitor how
much space has been used and keep the composition within the space limits of an AOD.
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4. Save the composition:
"* Click on File then Save As Final Composition.
* Enter a filename and description when prompted.

5. Reopen the same composition. (As a security measure, MMC requires that the user opens a final
composition and not modify it prior to building the AODI):
* Click on FE then Open Final Composition.

* Scroll through the list and select the AOD composition (not the MPS composition) just created.
MMC will display the templates on the world map.

6. Build the AODI and MPS images (MMC automatically builds both):
"* Click on Tools, then AOD Options, then BuildAOD Image.

"* MMC will pop up a Data Sources Window (Fig. 77) that lists which data sources are needed
I CD-1995-C-MAP3-10001 and CD-1996-B-MAP3-2003 }.

"* MMC will also pop-up the CD-ROM Site Window (Fig. 80).
"* Load the necessary CAC CDs in the CD changer. From the CD-ROM Site Window, select all

drives with the required CDs. Click on Scan Readers, then Start Processing (Section 4.1).
MMC will now build the AOD and MPS images.

"* Wait until MMC says the image build is complete { 2 minutes } before continuing with the next
step.

7. Open the AOD image and review it:
"* Click on File, then Open Image. Follow the directions to open the new AOD image file from the

hard disk.
"* View the CAC data in the AODI by clicking on an area of interest with the right (third) mouse

button (Section 4.3).

8. Archive the AODI to CD:
"* Click on Tools, CDROMOptions, Archive Data to CDROM(Section 3.3.6.2.1).

"* The Archive to CDROM Window will open. From this window, click on FiLe then
PreMaster... then AOD.

"• Wait until MMC finishes Premastering before continuing { 2 minutes }.
"• Insert a blank CD face-down in the CD caddy, then load the caddy in the CD writer. Wait until

the CD writer's green Disc light is ON (not blinking) before continuing.
"* Click on File (still in the Archive to CDROM Window) then Cut.
"* Wait until the CD writer has finished writing to the CD before continuing! Important: even after

MMC says the write is finished, wait until the CD writer's Read (green) and Write (red) lights
stop blinking! (There is no other way for the CD writer to "tell" MMC that the write is finished).
The green Disc and 4x lights will stay on.

"* Select Close from the Archive to CDROM Window to return to the MMC Window.
"* Again, be sure the CD writer's Read and Write lights have stopped blinking, then eject the CD

from the CD writer.
"* Label the CD with an indelible pen. Include the date, AOD image library ID, a descriptive title,

and a volume label.

9. Review the archived AODI from CD:
* Load the AODI CD in the CD changer caddy (Section 4.1).



MMC Version 3.5 Software Users' Manual 71

* In the main MMC Window, click on File, then Oen Image (Ctrl-1). Follow the directions to
open the AOD image file from CD.

"* View the CAC data in the AOD image by clicking on an area of interest with the right (third)
mouse button (Section 4.3).

10. Open the MPS image and review it:
"* Click on File, then Open Imaze (Ctrl-I). Follow the directions to open the MPS image file from

the hard disk.
"* View the CAC data in the MPS image by clicking on an area of interest with the right (third)

mouse button (Section 4.3).

11. Archive the MPS image to CD: repeat step 8, substituting MPS for AOD in the Premaster...
selection.

12. Review the archived MPS Image from CD: repeat step 9, substituting MPS for AOD in Open Image
selection.

4.5 Add Data to an Existing Composition

This section describes how to add a new scale of CAC data to an existing composition. To use this as
a tutorial, use the sample instructions given in { } to add new data to the composition designed in Section
4.4.

1. Choose a new scale and geographic area for the data to be added { JOG }.

2. Log any new data sources required { CD-1996-B-MAP2-20007: Western US at JOG Scale } - see
Section 4.2. Zoom-in on an area to show previously logged data sources.

3. Display all available coverages (Section 4.4, step 2). If necessary, zoom into an area of interest
(Section 3.2.4. 1).

4. Open the final composition to be modified:
"* In MMC, click on Coverage, then Include Final Comiposition or type Cirl-Insert (see Section

3.3.4.2.).
"* Scroll through the list of available compositions and select the desired AOD composition { the

composition built in Section 4.4, step 4 ). MMC will display the templates for that composition
on the world map.

5. Define additional template(s) for the new scale:
* Tip: copy existing template(s) from one scale 4 TPC ) scale to a new scale I JOG):

Click on Edit, Select All. The templates will turn yellow.

- Click on Ei then Copy (Ctrl-C).

- Change scales by clicking on the Chart Series / Ma4 Scale selection box in the lower-right
corner of the MMC Window and selecting the new scale ( JOG ). MMC will clear the
world map of all current templates, in preparation for defining templates in this new scale.

- Click on Edit, then Paste (Ctrl-V). MMC will paste the previously selected templates into the
new scale. Note that the size of the segment boxes will be different than they were in the
previous scale, since segment size is scale-dependent. Also note that the new template will
only include those segments that have been logged, to date.
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* If desired, modify these templates in the new scale, by using one of the coverage definition
buttons (Section 3.2.3).

* As in Section 4.4, use the Composition Data Size Display (Section 3.3.8.1) under Windows to
monitor how much space has been used, and keep the composition within the limits of an AOD.

6. Review the CAC data at the new { JOG } scale by clicking on the area of interest with the right
(third) mouse button. From the CD-ROM Site Window, select the CD reader containing the new
CAC CD { CD-1996-B-MAP2-20007 }, then click on Scan Readers, then Start Processing.

7. Save this work: click on File, then Save As Final Composition. { Give this composition a different
name from the one used in Section 4.4, step 4 }.

8. Reopen the new composition, build an AODI and MPS-CDI, review these images, and archive either
or both to CD, as described in Section 4.4 (steps 5-12).

4.6 Copying an AOD Image to an AOD

This section summarizes the procedure for copying an AOD Image to an AOD. To use this as a

tutorial, use the sample instructions in { ).

1. Place an AOD in the DMU:

* Turn off the DMU (use the power switch on front).

* Load an AOD containing chart data in the DMU.

* Turn the DMU back on.

* Wait 30 seconds after loading the AOD in the DMU before continuing.

2. Reopen the AOD Image: in MMC, click on Fil.e, then Open Image. Follow the directions to open the
Aircraft Optical Image from hard disk,

3. Click on Tools, then AOD Options, then Copy AOD Image to Worm.

4. A verification message will appear: click Yes.

5. An Information box appears to obtain the AOD serial number, and side to be written.

Note: When a blank AOD is being used, MMC automatically begins the write procedute. If the AOD
already contains data, it may either be recycled (i.e., all previous data are lost) and written with the new
image or, the AOD can be appended (with no loss of existing data). If the AOD contains data from a
failed write operation, MMC will offer to recycle it for use. Make sure an AOD is properly installed in
the DMU, with the write-protect tab in the up (T) position and that the DMU is turned on.

Recommendation: label each AOD with the serial numbers of both the DMU and DMUI used to
write the AOD. If there have been three write operations made to the AOD (i.e., the original write plus
two appends), there should be three sets of DMU and DMUI serial numbers on the label (some may be
duplicates).

6. As the image is copied to the AOD, a meter will show its progression until completion.

7. After the copy is complete, view the image from the AOD (Section 4.3.1).
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4.7 Checklists

4.7.1 Viewing Existing Checklists from an AOD

Related section: 3.3.6.3 (Data Frame Manager under the Tools menu).

1. Mount an AOD containing checklists in the DMU:

o Turn off the DMU (use the power switch on front).

o Load an AOD containing chart data in the DMU.

* Turn the DMU back on.

0 Wait 30 seconds after loading the AOD in the DMU before continuing.

2. In MMC, click on File, then Open Image. Follow the directions to open an AOD image from the
DMU. If an image has just been written to the AOD, it must be reopened again.

3. View checklist data: click on Tools, then View Dataframes from an AOD (Fig. 87). It will take
MMC several seconds to display the Dataframe Viewer Window (Fig. 88). When it does, scroll
through the available checklists for this AOD (Fig. 89).

Fig. 87 - View Dataframes from an AOD option
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Fig. 88 - Dataframe Viewer Fig. 89- Sample dataframe

4.7.2 Editing Checklists on the Hard Drive

MMC only permits editing of checklists on the Map-lI hard drive - not on an AOD. In MMC, click on
Tools, then Dataframe Manager and refer to Section 3.3.6.3 for detailed instructions of how to edit
checklists.

4.7.3 Copy a Checklist to an AOD

1. Place an AOD containing an image in the DMU (see Section 4.3.1, step 1).

2. In MMC, click on Fe then Open Image to open an AOD image. An AOD image must exist on an
AOD before checklists can be written to it.

3. Select AOD as the image type to open, then select DMU as the device.

4. After the AOD image is loaded, click on the Tools menu, then AOD Options, then Copy Checklist to
WORM (see Section 3.3.6.1.6). Follow the directions given by MMC to copy a checklist set from the
MMC hard disk to the AOD.

4.8 Scan a Chart and Archive the Data to CD

1. Scan a chart: follow the instructions given in Section 3.3.6.5 to scan a chart into MMC, clip the
image, georeference the scanned chart data using user-specified control points, transform the data to

BEST AVAILABLE Copy
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the selected datum, scan adjacent charts (if desired), compress the data into the CAC format, and
review the final scanned CAC ("SCAC") image.

2. Archive the SCAC data to CD: follow the instructions given in Section 3.3.6.2 to archive scanned
data to CD.

3. Log-in the SCAC CDROM: follow the instructions given in Section 4.2 to log a SCAC CD into
MMC.

4. Review the archived SCAC data from CDROM:

" Click on Preferences then be sure the View [Data source] item in that menu is View Processed
CDROM. If not, click on the View [ Data source ] item and choose View Processed CDROM
from the drop-down list (see Section 3.3.5.2).

" Follow the instructions in Section 4.3.2 (Viewing chart data from a CAC CD), steps 3-8,
substituting "SCAC" for "CAC" in each step.

5. Delete scanned data from the MMC hard disk: once the user is satisfied that the data on the new
SCAC CD is satisfactory, he or she can delete the scanned data from the hard disk.

4.9 Build an MPS CD with DTED, CAC, and Scanned CAC (SCAC) data

This section summarizes the procedure for building an MPS CD using DTED and Scanned CAC
(SCAC) data. To use this section as a tutorial, use the samples given in I

1. Display the existing DTED coverage overlay:

"* Click on File, then New.

"* Click on Preferences, then Composing AOD ON, then Compose MPS.

"* Switch the data series to DTED using the Chart Series / Map Scale button in the lower-right
comer of the main MMC Window.

"* Zoom into the area of interest { Hawaii and SW California ) using the Zoom-in on a Stretch-
Box button.

"* Click on Overlays, then Available Coverage.

"• MMC will display the coverage of all existing, logged DTED CDs in the area of interest.

2. If necessary, log in any additional DTED CD(s) required { TCD DTEDi40 }, as described in Section
4.2.

3. Design compositions { Hawaii and China Lake } using SCAC, CAC, and DTED data:

"* Define DTED area(s) of coverage using the coverage definition buttons in the lower-left corner of
the main MMC Window (Section 3.2.3.2).

"• MMC will display the defined DTED area(s) in colored boxes, where the color reflects the TS
zone of the data, and each box represents a TS segment (see Section A2.5 for more information
on TS zones and segments).

"* Switch the data series to a new series I JOG } using the Chart Series / Map Scale button in the
lower-right comer of the main MMC Window.
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* Click on Overla.s, then Available Coverage. Available map data I all JOG data that is logged in,
to date ) will be displayed: CAC data in gray, scanned data in tan, and a combination of CAC and
scanned data in purple.

* Define map area(s) of coverage using the coverage definition buttons in the lower-left comer of
the main MMC Window (Section 3.2.3.2).

* To be sure the composition is not getting too large, click on Windows, then Composition Data
Size Display to see a dynamic meter showing how much space has been used, and whether the
image has exceeded the limit for this scale of data. I Note: to keep a tutorial short, try to keep
each data coverage around 5 tol0 MB in the meter; if either DTED or JOG is larger than 10 MB,
trim the coverage using one of the Erase Coverage buttons at the bottom of the MMC Window.)

4. Save this work: click on Fe then Save As Final Composition.

5. Reopen this composition. (As a security measure, MMC requires that users open a final composition
and don't modify it prior to building the MPS-CDI):

+ Click on File then Open Final Composition.

* Scroll through the list of available compositions and select the MPS composition just created.
MMC will display the composition on the world map.

6. Build the MPS image:

"* Click on Toolos then MPS Options, then BuildMPS Image.

"• MMC will pop up a Data Sources Window listing which data sources (e.g., CAC CDs) are
needed.

"• MMC will also pop-up the CD-ROM Site Window.

"• Insert all the necessary CAC, SCAC, and DTED CDs (listed in the Data Sources Window) in the
CD changer caddy, then load the caddy into the CD changer. Click on Scan Readers, check that
the correct CDs are loaded, then click on Start Processing. MMC will now build the MPS image.
(For more information on loading and selecting CDs in MMC, see Section 4.1.)

7. Wait until MMC completes the MPS image build before continuing to the next step.

8. Open the MPS image and review it:

"* Click on File, then Open Image (Ctrl-]). Follow the directions to open the MPS image file from
the hard disk.

"• Click on Preferences, then on the View [Data sources 1 drop-down list. Select View MPS Hard
Disk.

"• View the CAC data in the MPS image by clicking on an area of interest with the right (third)
mouse button. (See Section 4.3 for more information on viewing data).

9. Archive the MPS image to CD:

• Click on Tools, then CDROM Options, then Archive Data to CDROM.

* The Archive to CDROM Window will open. From this window, click on Fil.e, then PreMaster
then MPS. See Section 3.3.6.2 for more information on archiving MPS data to CD.

10. Review the archived MPS Image from CD:

• Insert the MPS CD in an empty slot in the CD changer caddy, then load the caddy in the CD
changer.
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"* In the main MMC Window, click on File, then Oven Image (Ctrl-1). Follow the directions to
open the MPS image file from CD.

", View the CAC data in the MPS image by clicking on an area of interest with the right (third)
mouse button. (See Section 4.3 for more information on viewing chart data).

4.10 Build an MPS Image from an AODI on an AOD

This section specifies how to build an MPS Image from an AODI on an AOD.

I. Mount an AOD containing chart data in the DMU (Section 4.3.1).

2. Open the AOD Image and extract the composition:

"* In MMC: click on File, then New.

"* Click on Coverages, then Include Image. Follow the directions to open an AOD Image from the
DMU.

" Save the composition from the AOD to the MMC hard disk: click on File. then Save As Final
Composition. Enter filename and description of the final composition.

" Note: If all the sources have been logged in for this composition, MMC will let the user save it. If
not, those that are not available will be removed from the composition and displayed; click on
File, and Save As Final Composition again.

"* Reopen this composition. (As a security measure, MMC requires that users open a final
composition and don't modify it prior to building the MPS): click on , then Oven Final
Composition. Scroll through the list of available compositions and select the MPS composition
(not the AOD composition) just created. MMC will display the composition on the world map.

3. Build the MPS image:

"• Click on Tools, then MPS Options, then Build MPS Imagge.

"* MMC will pop up a Data Sources Window (Fig. 75) listing which data sources (e.g., CAC CDs)
are needed.

" MMC will also pop-up the CD-ROM Site Window (Fig. 78):

- Insert all necessary CAC, SCAC, and DTED CDs (listed in the Data Sources Window) in
the CD changer caddy, then load the caddy into the CD changer.

- From the CD-ROM Site Window, select all the CD drives that contain the necessary CDs for
this operation. See Section 4.1 for more information about selecting and mounting CDs for
use in MMC.

- Click on Scan Readers, check that the correct CDs are loaded, then click on Start Processing.

"* MMC will now start building the MPS image. MMC will ask if the user wants to delete the
previous MPS Image from disk. Answer Yes - there can only be one image resident on the hard
disk at a time. MMC will delete the old Image from hard disk, then build the new image.

"* Wait until MMC completes the MPS image build before continuing to the next step.

4. Open the MPS image and review it: refer to Section 4.4, step 10.

5. Archive the MPS image to CD: refer to Section 4.4, step 11.

6. Review the archived MPS Image from CD: refer to Section 4.4, step 12.
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Appendix A

AV-8B MAP-Il COMPONENTS

Alphastation
The Central Processing Unit (CPU) for the AV-8B MAP-Il is an Alphastation 255/233 (manufactured

by Digital Equipment Corporation) with the following configuration:

1) 64 MB of parity memory

2) 4.3 GB of disk space

3) 1 high-resolution 17" color monitor

4) 1 VMS-style keyboard

5) 1.44 MB floppy diskette drive (SCSI)

6) PCI-to-SCSI host bus adapter

At the time of the initial Map-II purchase (FY96), each of these Aiphastations cost about $14,500
(GSA price) and came with a 1-year warranty.

AOD

An Aircraft Optical Disk (AOD) is a militarized Write-Once, Read-Many (WORM) Optical Disk that
NRLSSC procures from Honeywell (part number 8509831) for $1,230 each under contract #N00014-93-
C-6016. A Japanese company developed specialized glass with a proprietary coating to be used for these
AODs. However, this company stopped production of the glass components in 1993. Honeywell
purchased a large quantity of glass to continue producing AODs for NAVAIR as a "last-time buy"
agreement.

An AOD is two-sided and contains up to 260 MB of data per side. Current aircraft moving-map
systems can only access one side of the AOD at a time; the aircraft must land before the pilot can flip the
AOD to access the other side. The data is stored in the form of an AOD Image (AODI).

Data cannot be deleted or overwritten on an AOD, but old data can be "skipped" (i.e., ignored), and /
or new data can be added to an AOD in the form of a new AODI. Up to 16 AODIs can be written to -
and accessed from - an AOD, if the total space used by these images does not exceed 260 MB.

AODI

An Aircraft Optical Disk Image (AODI) is an exact replica of the information to be written to an AOD.
Depending on a user's choice, MMC will write an AODI to a file on the Alpha disk, archive it to
recordable compact disk (CD-R), or copy it to an AOD via the DMU.
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CD Changer

The Compact Disk (CD) Changer installed on the MAP-Il holds up to 6 CDs at one time, although the
workstation can only access one at a time; i.e., the CD changer is treated as a single device. (For more
information about using the CD changer on the MAP-I workstation, see Section 4.1: "Loading and
Selecting CDs in MMC"). The CD changer supports quad-speed reads from CD-ROM and CD-R. The
systems were purchased from Acersoft Corporation for approximately $2,000 each in FY96.

CD Recorder

The CD Recorder installed on the Map-Il is a Yamaha CD Studio with quad-speed Kodak PCD225 CD
writer (part no. 120135), purchased from BTG, Inc. The price in FY96 was $10,475, although that price
has since dropped (reference: NAWC, Indianapolis). MMC uses an NRL-developed CD-R Graphical
User Interface (GUI) to archive various information to CD; e.g., MPS-CDIs, AODIs, and scanned map
data.

Digital Video Map Set

The AV-8B Digital Video Map Set is comprised of a Digital Map Computer, Color Display, and
Digital Memory Unit (DMU). Together, these components provide an in-flight, near-real-time, digital
moving-map capability to the AV-8B.

The moving-map system is supported by the ground-based AV-SB Mission Support Systems (MSS):
the Maintenance Data System-Il (MDS-ll), Mission Planning System-lI (MPS-ll) and the Map-li
workstation. The MDS-11 extracts aircraft maintenance information that is written in-flight to a reserved
portion of the DSU memory. The MPS-II System allows a mission planner to design mission overlays
(e.g., threats, routes, targets, etc.) to be loaded in the aircraft's Mission Computer via the DSU. The Map-
II workstation allows an operator to define, tailor, and build map theaters for a given area of operations.
These map theaters are also loaded in the aircraft's Digital Map Computer, via an AOD.

The Digital Map Computer and Display Computer combine the map data (built on the Map-li) with the
mission data (built on the MPS-Il) and display the resulting image on a 4.5" x 4.5" color monitor in the
aircraft. Once the mission is completed, the MPS-I1 operator can erase the DSU and reprogram it with
new mission data without altering the base map on the AOD.

DMU and DMUI

The Digital Memory Unit (DMU) was used in the original MOMS system and is'now used in the
MAP-Il workstation. The DMU (Honeywell part #8509830-002) is used exclusively for writing
militarized AODs. The DMU communicates with the Alphastation via a DMU Interface (DMUI, HTI part
number DMUI-01), which translates between the Honeywell DMU's fiber optic protocol and the
computer's SCSI-I protocol. NRLSSC developed the OpenVMS-based driver on the Alphastation to
communicate with the DMU via the DMUI.

MOMS

The Map, Operator, and Maintenance Stations (MOMS) were developed by HTI to support map,
mission planning, and maintenance operations. The MOMS were used to define map coverages at
various scales and copy selected map data to an AOD, define necessary mission overlays, and copy those
to a DSU, etc. All of the AV-8B MOMS functions have been replaced by the AV-83 Muxbus Data
System (AMDS-ll): the Map-Il workstation and Moving-Map Composer (MMC) software replaces the
MOMS' Map Station, the MPS-I1 replaces the MOMS' Operator System, and the MDS-ll replaces the
MOMS' Maintenance System.
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MPS

The Mission Planning System 11 (MPS-II) was developed by NAWC Weapons Division, China Lake,
CA, to replace the mission planning portion of the Horizons Technology, Inc. (HTI) MOMS. The MPS-II
is based on a portable notebook computer with a 120 MHz Pentium processor.

MPS-CD

The Mission Planning System Compact Disk (MPS-CD) stores up to 650 MB of map data in the form
of an MPS-CDI. The MPS CD is the sole link between the Map-Il and MPS-11 systems.

MPS-CDI

The Mission Planning System Compact Disk Image (MPS-CDI) contains CAC data, sometimes
supplemented with DTED, of an area of interest for mission planning purposes. An MPS operator uses the
MPS CDI map coverage to design and position mission overlays, such as threats, routes, targets,
waypoints, etc., which are then stored on a DSU and installed in the aircraft, along with the AOD (which
stores the map coverage).

Scanner

The MAP-11 workstation uses the original flatbed Howtek "Scanmaster" scanner that was procured for
the MOMS in FY90. This scanner can scan at 300, 200, 150, 100, and 75 dpi (dots per inch). The MAP-Il
will implement only the 300 dpi (highest resolution) scan. To integrate this scanner in the Map-Il, a
General Purpose Interface Board (GPIB) board was procured from National Instruments ($495 each), and
a software driver was procured from EQUlcon Software ($575 each).

MMC scans paper charts and processes them into the CAC format, to be included in AODIs and MPS-
CDIs as required, to supplement existing CAC data. Scanned data should be used if there is no CAC data
available for the area of interest, or if there are more recent paper charts that have not yet been distributed
as CAC by the National Imagery and Mapping Agency.



Appendix B

SETTING UP THE MAP-II WORKSTATION

The following procedure details how to set up the Map-Il workstation and connect all the peripherals:

1) Unpack all equipment from the boxes.

2) Arrange equipment in workspace:

* Set DMUI on table;

* Place CD writer on top of DMUI;

* Place Alpha CPU on top of CD writer;

* Place CD changer on top of the CPU.

* Place monitor, keyboard, and mouse next to stack of equipment.

* Place scanner on a table with enough clearance for the moving scan bed.

3) Plug peripherals into the back of the CPU:

" Monitor: Plug the monitor's video cable into the video port on the CPU (in the upper-right comer
of the back of the CPU box: pictures of a monitor and sunglasses label this port).

" Keyboard / Mouse: Plug the keyboard and mouse into their respective ports on the CPU (in the
lower-center: pictures of a keyboard and a mouse label these ports).

" Scanner: Plug the scanner cable into the GPIB port on the CPU box (in the right-center - the port
is labeled GPIB).

" CD changer: Plug one of the Centronix - High Density SCSI cables into the internal SCSI port on
the CPU box (SCSI A, located next to the keyboard and mouse connections). Plug the other end of
the cable into the CD changer's SCSI port (use the port on the right, above the power plug, on the
CD changer). Plug a SCSI terminator into the other CD changer SCSI port.

" CD writer: Plug the other Centronix - High Density SCSI cable into the external SCSI port on the
CPU box (SCSI B, located between the monitor and the scanner connections). Plug the other end
of this cable into the CD writer SCSI port labeled "host" (the right-most SCSI port, when viewing
the CD writer from the back).

" DMUI: Plug the Centronix - Centronix cable into the other SCSI port on the CD writer. Plug the
other end of this cable into either of the DMUI SCSI ports. Plug a SCSI terminator into the
remaining DMUI SCSI port.

4) Power:

"* Plug power cords into each peripheral (scanner, DMUI, CD writer, CD changer, CPU and
monitor) then plug into unplugged power strip.
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"* Check that all equipment is turned OFF at their individual power switches BEFORE plugging in
power strip.

"* Plug in and turn on power strip.

"• Turn on the peripherals in the following order:
I) DMUI (power switch on the back, then on the front of the box)
2) CD writer, CD changer, scanner, and monitor
3) Map station CPU

5) Check Device Configuration and Boot Map Station:

"* Wait until the Map Station's >>> prompt is displayed.

"* Check that the CD writer's red HDD light is off. If it is on, press the RESET button on the front of
the CD writer (which will turn off the light), then, at the >>> prompt on the Map Station monitor,
type INIT.

" When the >>> prompt returns on the Map Station monitor, wait 5 tol0 s, then type SHOW
DEVICE. The Map Station should display a listing similar to that shown in Table Bi.

Table BI - AV-8B MAP-1I Device Listing at Boot Prompt

DEVICE ID Device name Description (not listed)

DKAO RZ26F System disk

DKA100 RZ29B MMC disk

DKA200 Pioneer CD-ROM DRM-624X CD changer device MMC1

DKA201 Pioneer CD-ROM DRM-624X CD changer device MMC2

DKA202 Pioneer CD-ROM DRM-624X CD changer device MMC3

DKA203 Pioneer CD-ROM DRM-624X CD changer device MMC4

DKA204 Pioneer CD-ROM DRM-624X CD changer device MMC5

DKA205 Pioneer CD-ROM DRM-624X CD changer device MMC6

DKA400 RRD45 Internal CD device- MMC7

DKB401 Toshiba CD-ROM Drive:XM CD Writer drive

DVAO Internal floppy disk drive

MKB400 CD Studio device

EWAO Ethernet (e.g., 00-O0-F8-22-64-OD)

PKAO SCSI Bus ID 7 Internal SCSI Bus - A

PKBO SCSI Bus ID 7 External SCSI Bus - B

If this listing is incomplete or inaccurate: turn off the CPU, then turn off the power strip, then turn
the power strip back on, and turn the CPU back on. Repeat the CD writer checks (and RESET if



MMC Version 3.5 Software Users' Manual 85

necessary), >>INIT and >>>SHOW DEVICE commands. If the device listing is still inaccurate,
repeat this power cycle I or 2 more times, then call Bob Murray at Hughes, Indianapolis, IN.

When the device listing is correct, type B (for boot) at the >>> prompt. It will take about 3 min to
completely boot up the system.

6) Login:

Username: MMC

Password: 8675309



Appendix C

GLOSSARY OF ACRONYMS AND TERMS

C1. PROCESSING TERMS

Composition (or Template)

A composition is a user-defined geographic coverage area (or set of areas) saved as a series of bitmaps
(Fig. Cl). A composition includes a bitmap for each contiguous geographic area, within each TS zone,
and at each map scale required to build the user's AOD image or MPS image. Each "bit" in the
composition's bitmap(s) represents a single TS segment of CAC data (and / or DTED, if the user is
designing an MPS image).

Fig. CI -Sample MMC composition

Image

An image is the actual data set (including CAC data, scanned map data, DTED, or some combination
of these) to be copied to an AOD or MPS-CD. MMC constructs an image from a composition's bitmaps.
Figure C2 illustrates a sample image, comprised of CAC data.
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C2. DATA TYPES

ADRG

ARC (equal-Arc-second Raster Chart) Digitized Raster Graphics (ADRG) is a standard, digital, raster
chart product produced and distributed on CD-ROM by NIMA. To produce ADRG, paper charts are
scanned and transformed into the ARC system frame of reference. Data collected from a single chart /
chart series and scale are maintained as a worldwide, seamless, data base, in which each pixel is
represented by a 24-bit RGB (red, green, and blue) color value and exists at a distinct geographic
location. All ADRG data have been adjusted to the World Geodetic System 1984 (WGS 84) horizontal
datum. ADRG is the source data for both CAC and CADRG. For more details, refer to NIMA's
Digitizing the Future report or website (NIMA 1997).

Fig. C2 - Sample image (chart data)

Compressed Aeronautical Chart (CAC)

The CAC database is a compressed (48:1) form of ADRG. CAC originally was produced by NRL and
now is produced and distributed on CD-ROM by NIMA. CAC is the base map for current AV-813 and
F/A-18 moving-map displays (future systems - e.g., TAMMAC - will use CADRG instead). CAC is
organized into Tessellated Spheroid (TS) segments, as described in the TS definition (below).

To produce CAC, NIMA converts ADRG digital map images from the ARC system frame of reference
into the TS projection using a neighborhood averaging function, which effectively reduces the resolution
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of the data from 256 pixels per inch (ppi) to 128 ppi for compatibility with current aircraft moving-map
displays. The averaged data values are then color-compressed from 24 bits per pixel (full-color data) to 8
bits per pixel according to a predefined color palette. The data are also spatially compressed, a process
that replaces every nonoverlapping group of 2 pixels x 2 pixels in the data set with a I-byte codeword and
creates a unique codebook for every 2" x 2" segment of data. The final data compression ratio for CAC is
48:1 over ADRG. Since most ADRG CD-ROMs are not filled to capacity, while most CAC CD-ROMs
are filled, there may be over 65 ADRG CD-ROMs compressed onto a single CAC CD-ROM. See
Lohrenz and Ryan (1990) for more details.

Compressed ADRG (CADRG)

Produced and distributed on CD-ROM by NIMA, CADRG was designed to be a jointly coordinated
compression of ADRG to be used in any application requiring rapid display of a map image or
manipulation of the image of a map in raster form. CADRG achieves a nominal compression of 55:1 over
ADRG, excluding supplemental data such as color palettes and codebooks. CADRG is processed
similarly to CAC, except that CADRG has a data density of 169 pixels per inch (CAC is 128 ppi) and
CADRG maintains the ARC coordinate system of ADRG (CAC uses the Tessellated Spheroid projection
system). CADRG will replace CAC as the standard raster chart data to be used in the TAMMAC cockpit
moving-map systems. For more details, refer to NIMA's Digitizing the Future report or website (NIMA
1997).

Digital Terrain Elevation Data (DTED)

DTED is a uniform matrix of terrain elevation values that provides basic quantitative data for systems
that require terrain elevation, slope, and/or gross surface roughness information. DTED is produced and
distributed on CD-ROM by NIMA. DTED is available at two different resolutions:

"* Level 1: Content is comparable to the contour information represented on a 1:250,000 scale chart.
Latitudinal post spacing is 3 arc seconds (about 100 m); longitudinal post spacing varies by
latitude (see Table C I).

"* Level 2: Content is comparable to the contour information represented on a 1:50,000 scale chart.
Latitudinal post spacing is I arc second (about 30 in); longitudinal post spacing varies by latitude
(see Table C i).

Table Cl- DTED Longitudinal Post
Spacing (Level I vs Level 2)

- Post Spacing
(arc sec)

Zone Lat Bounds Level I Level 2

i 00- 500 NIS 3 1
II 50 0 - 700 N/S 6 2

II1 70 0 - 750 N/S 9 3

IV 75 0 - 800 N/S 12 4

V 80- 900 N/S 18 6

For more information about DTED, refer to NIMA's Digitizing the Future publication or website
(NIMA 1997).
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Tessellated Spheroid (TS)

TS is the projection system used to store CAC data. TS was developed by Honeywell, Inc. as a
structure for seamlessly storing and displaying global chart data on a cockpit moving-map display. TS
stores CAC data in rectilinear segments, where one segment is characterized as follows:

* 2" x 2" section of scanned paper chart;

* 256 pixels x 256 pixels of raster data;

* a single file on the CAC distribution CD;

* smallest piece of data in MMC (drawn as a square bisected by a diagonal line).

TS organizes these segments into five geographic zones, as listed in Table C2. There is an overlap
between zones (not reflected in Table C2), such that two rows of segments from each zone extend into the
adjacent zone. This minimizes display "jumping" if a pilot is flying along a zone boundary. The amount
of overlap in degrees of latitude is scale-dependent (since the size of a segment depends on the scale).
For more information about the TS projection system, refer to Lohrenz et al. (1993).

Table C2 - TS Geographic Zones

Zone Zone N latitude S latitude
ID name bound bound
0 North Polar 90.00 deg N 51.69 deg N
I North 51.69 deg N 31.38 deg N
2 Equatorial 31.38 deg N 31.38 deg S
3 South 31.38 deg S 51.69 deg S
4 South Polar 51.69 deg S 90.00 deg S

World Vector Shoreline (WVS)

WVS is the base map for defining coverages for AOD images and MPS-CD images on the MAP-1I
workstation. WVS is a standard NIMA digital product consisting of the shorelines, international
boundaries, and country names of the world. The uncompressed version of WVS averages 12 data points
per nautical mile (nmi), approximately equivalent to the data density of a scanned 1:250,000 scale map.
WVS conforms to the World Geodetic System 1984 (WGS 84) datum. Compressed and thinned versions
of WVS are also available from NIMA. For more details, refer to NIMA's Digitizing the Future (NIMA,
1997).

C3. CHART SERIES, SCALES, AND DISPLAY RANGES

Chart series and geographic scale typically refer to paper chart products: a Joint Operations Graphic
(JOG) chart series is produced at a scale of 1:250,000, which means that 1" on the chart represents
250,000" on the ground. For aeronautical charts, larger scales (e.g., 1:50,000 and 1:100,000) provide
more detailed map information for low altitude flying or approach and landing operations. Smaller scales
(e.g., 1:2,000,000 and 1:5,000,000) are used for faster flying at high altitudes (e.g., cross-country flights).

The term map scale is not always appropriate for digital map products, since the actual scale may
become distorted by zooming or subsampling the data. For digital charts, it may be more useful to refer to
display range: e.g., the number of nautical miles from the top to the bottom of the screen on which the
digital chart is displayed.
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Table C3 is a list of the common aeronautical chart series, along with their geographic scales and
normal (pre-zoom) display ranges. The table also indicates, for each chart series, if it is supported by
current moving-map displays and if it will be supported under the new TAMMAC systems.

Table C3 - Common Aeronautical Chart Series, Scales, and Display Ranges

Display Range In In
(nmi)2 current TAMMAC

Chart series Scale" AV-8B F/A-18 system? system?
Global Navigation Chart (GNC) 1:5M 200 160 No Yes
Jet Navigation Chart (JNC) 1:2M 100 80 Yes Yes
Operational Navigation Chart (ONC) 11 M 50 40 *3 Yes

Tactical Pilotage Chart (TPC) 1:500k 25 20 Yes Yes
Joint Operational Graphics (JOG) 1:250k 13 10 Yes Yes
Topographic Line Map-100 (TLM- 1:100k 5 4 Yes Yes
Topographic Line Map-50 (TLM-50) 1:50k 3 2 No Yes
".1 For map scales, M = million, k = thousand.

2' AV-8B and FIA-18 use the same display but calculate range differently (Trenchard et al.1995).

"3 The ONC series is not supported in current systems; instead, pilots can zoom into the JNC chart by
2:1 to simulate an ONC display range.

C4. AGENCIES AND COMPANIES

Defense Mapping Agency (DMA)

DMA has been reorganized and renamed to the National Imagery and Mapping Agency (NIMA). See
description, below.

Honeywell

As subcontractor to McDonnell Douglas, Honeywell manufactured and distributed most of the
hardware components for the AV-8B and F/A- 18 cockpit moving-map systems, including the DMU used
by both the Map Station and the cockpit map computer. Honeywell also developed the TS projection
system and CAC database format, specifications, and original compression software, which were later
transitioned to NRL. NRL made significant modifications to the CAC compression software before
transitioning it to NIMA in September 1995.

Horizons Technology, Inc. (HTI)

HTI is the original manufacturer and distributor of the MOMS system. HTI is located in San Diego,
CA.

Naval Air Weapons Center (NA WC)

NAWC Weapons Division, China Lake, CA, retrofitted the MOMS software with Pentium PC
platforms to develop the Mission Planning System-ll (MPS-ll) and Maintenance Data System-ll (MDS-
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II) for the AV-8B Muxbus Data System. NAWC tasked NRL to develop the Map-lI workstation for
AV-8B. The following are key NAWC personnel in this effort:

Project Team Leader: Diana Lemon

, Project Engineers: Luie Trudy, Jean Carlton

National Imagery and Mapping Agency (NIMA)

NIMA - formerly the Defense Mapping Agency (DMA) - produces and distributes the standard
cartographic databases that support the cockpit moving-map, Map-Il, MPS-ll, and MDS-ll systems,
including CAC, DTED, and WVS.

Naval Research Laboratory (NRL)

The NRL Mapping Sciences Section (Code 7440.1) developed the Map-II workstation and Moving-
Map Composers (MMC) software for the AV-8B Muxbus Data System. NRL Code 7440.1 is located at
the Stennis Space Center, MS, which is on the Gulf of Mexico approximately 70 miles northeast of New
Orleans, LA. The following are key NRL personnel in this effort:

* Project Team Leader: Maura Lohrenz
* Project Engineers: Marlin Gendron, Stephanie Myrick, and Michael Trenchard
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